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Chapter 3 
OpenOffice.org File Storage 

How does OpenOffice.org store files? Can it read files created in Microsoft Office and 
WordPerfect? Can I exchange files created by OpenOffice.org with people using other 
Office suites? 

Probably the first issue anyone thinks about when contemplating a change in their office  
suite is the body of documents they already have. Second on the list is the ability to share 
documents with others. Microsoft Office is ubiquitous today—you can send someone a .doc  
or .xls file and feel fairly confident they will be able to read it and even edit it. OpenOffice.org 
has its own file formats, but it also has the ability to read and write files in a variety of  
other formats. 

Where does OpenOffice.org store my files? 
Before looking at how OOo stores files, let’s address the issue of where it stores them. As in 
most applications, you can specify the exact location and name of a file when you save it. 
However, as in Office, you can provide a default location to cut down on navigation. 

The Options dialog (Tools | Options on the menu) includes a Paths page (Figure 1) under 
OpenOffice.org. You may want to change several of the items on this page to match your 
normal working environment. To change any item, highlight it and click the Edit button. 

 
Figure 1. You specify the default location of documents and templates on the Paths 
page of the Options dialog. 
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The My Documents item specifies the default folder for documents. The first time you 
open a document in any OOo session, the Open dialog defaults to that location. (Once you 
open any document, the Open dialog defaults to the folder containing the most recently opened 
document.) When you save an unsaved document, the Save dialog defaults to the My 
Documents folder as well. 

The Templates item lets you specify one or more folders that contain templates. When 
you choose to edit this item, the dialog in Figure 2 appears. You can add a number of folders 
to the list. When you choose to create a new document from a template, the templates from all 
those folders are listed. (For more on creating and using templates, see Chapter 5, “Making 
Life Easier with Templates and Styles.”) 

 
Microsoft Office limits the locations where templates can be stored. For 
example, in Word, you specify a single directory tree for user templates and a 
single one for Workgroup templates. OpenOffice.org lets you specify a list of 
directory trees containing templates. 

 
Figure 2. You can store templates in more than one place. Use this dialog to tell 
OpenOffice.org where to find your templates. 

How does OpenOffice.org store my files? 
As with other office suites, each of the OOo applications has a “native” format it can create 
with an extension that identifies its origins. Table 1 shows the native extension for each OOo 
application, as well as the extensions used for templates. 

Table 1. Each OpenOffice.org application uses one unique extension to identify its 
files and another for its templates. 

Application File Extension Template Extension 
Calc sxc stc 
Draw sxd std 
Impress sxi sti 
Master Document sxg (none) 
Math sxm (none) 
Writer sxw stw 
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However, when you dig inside, it turns out the formats for the different OOo document 
types are more similar than different. Each file saved on disk is really a compressed file in the 
Zip format. When you open it with an appropriate tool (like WinZip), you find a number of 
files inside. 

 Most of the files found in the Zip use XML, a format designed to carry information about 
structure as well as content. (For the adventurous, documentation on the structure of the XML 
files is available at http://xml.openoffice.org/xml_specification.pdf.) 

The compressed file for a particular document may contain files other than XML files. For 
example, every picture you use is included. 

What types of files can OpenOffice.org read? 
Each of the OpenOffice.org applications can read files other than the ones it creates. The Files 
of Type drop-down list in the Open dialog (Figure 3 shows a small portion of the list) lists the 
compatible types. 

 
Figure 3. The Files of Type drop-down list in the Open dialog shows the kinds of files 
OOo can read. Make sure to scroll through this list to see all the options. 

Most important for those coming to OOo from Microsoft Office is the ability to read 
Office files, including Word documents, Excel workbooks, and PowerPoint presentations, as 

http://xml.openoffice.org/xml_specification.pdf
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well as templates from those products. Most Office files appear unchanged in the appropriate 
OOo application, although some highly formatted documents may not survive the conversion 
exactly as originally formatted. 

If OOo can’t read a particular type of file, consider using the original application to save 
the file in another format OOo can read. In addition, development is underway for filters to 
import additional file formats (including, as of this writing, WordPerfect documents—see 
http://wp.openoffice.org for information), so be sure to check at www.openoffice.org  to see 
whether a newer version that supports your file format is available. 

How do I share files with other applications, such as 
Microsoft Office? 
Just as OpenOffice.org can read a wide variety of file formats, it can save to quite a few 
formats, as well. The Save As type drop-down list in the Save As dialog of each application 
lists the available formats. Figure 4 shows part of the list for Calc; as with opening files, be 
sure to scroll through the complete list of available formats. 

 
Figure 4. You can save files created in OpenOffice.org to a variety of formats. 

If you need to exchange most of the documents you create with Office users (or anyone 
else using something other than OpenOffice.org) , you can save yourself a lot of effort by 

www.openoffice.org
http://wp.openoffice.org
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setting up default save formats. To do so, open the Options dialog (Tools | Options) and 
expand the Load/Save section. Click General to display the page shown in Figure 5. In the 
Standard file format section near the bottom of the page, choose a file type from the list on the 
left, and then choose the default format for storing that kind of file from the drop-down list on 
the right. Once you do so, any new files you create are stored using the specified format. 

 
Figure 5. You can specify the default formats for saving new documents. This is a 
real time saver when most of your work involves sharing documents with Microsoft 
Office users. 

It’s worth noting that I wrote this book using the native .sxw format. Files were 
exchanged with both Windows and Linux users in that format. As the original manuscript was 
completed, files were converted to Word’s .doc format and again exchanged with both 
Windows and Linux users. 

Why have my Office files been converted to 
OpenOffice.org files? 
This may be the most frequently asked question by new users of OOo. During the installation 
process, you can choose whether to use OOo for Office documents (.doc, .xls, .ppt) or not. The 
wording on that page of the Setup process (Figure 6 in Chapter 2, “Installation and 
Configuration”) is ambiguous enough for many people to misunderstand it. 

For each item selected on that page, the file association is changed. That is, when you 
select “Microsoft Word Documents” on that page, you’re telling the Setup process to make 
changes on your computer so when you open a Word .doc file from Windows Explorer, it  
uses OOo instead of Word. This automatically changes the icon shown for the file as well. 
However, the file itself is unchanged and you can open it in Office using the File | Open  
menu item. 

If you allowed the associations to be changed when you installed OOo, but prefer to leave 
Office files associated with Office, you have a couple of choices. One solution is to uninstall 
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OOo and then reinstall it, making sure not to select those items. Another option is to right-
click any Office file in Windows Explorer and select Open With | Choose Program.... In the 
Open With dialog, choose the appropriate Microsoft Office application for that file and select 
Always use this program to open these files. You need to do this once for each type of file you 
want to re-associate with an Office program. 

Where are my OpenOffice.org settings saved? 
OpenOffice.org stores settings in a number of files spread across a number of folders. The 
name of the root folder for the group is User and its location depends on whether a single user 
or network installation was performed.  

For a single user, the User folder resides beneath the root OpenOffice.org folder. For a 
network installation, each user’s User folder is placed beneath the folder specified for that 
particular workstation installation. 

Wherever the settings are located, there are many folders beneath it. Each contains a 
subset of the settings. The files in those folders use several different formats, but many are 
either XML or compressed files containing multiple XML files. The key settings for each of 
the OOo applications are stored in files with names like Calc.XCU and Writer.XCU several 
folders below the Registry subfolder of User. 

In addition to your individual settings, the Share folder (also one level below the 
OpenOffice.org root folder) contains shared settings and the original default settings. 

What’s next? 
Now that you are reassured about using OpenOffice.org transparently with people you share 
documents with, the next chapter looks at the OOo user interface, especially the parts common 
to all the applications. 

 

 
 
 
 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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Chapter 4 
The OpenOffice.org Interface 

While the biggest concern in changing office suites may be file compatibility, the most 
difficult part of the process is unlearning old habits and learning how the new suite 
works. Fortunately, in OpenOffice.org, the applications have a lot in common, so once 
you start learning, much of what you learn applies to all of them. 

One of the appealing things about graphical user interfaces (GUIs) is the idea that knowledge 
is transferable from one application to another. For example, most Windows users expect the 
first three items on an application’s menu to be File, Edit, and View. They further expect the 
File menu to contain items for creating, opening, and closing whatever objects the application 
deals with and the Edit menu to include Cut, Copy, and Paste items. 

When applications are part of a suite, as with Microsoft Office or OpenOffice.org, users 
have a right to expect even more commonality. Fortunately, OpenOffice.org delivers. There 
are many features that work pretty much the same way, whether you’re using Writer, Calc, 
Impress, or even Draw. This chapter looks at the common features of OOo’s user interface. 

What does the OpenOffice.org interface look like? 
Not surprisingly, OOo looks a lot like other applications designed with GUIs. Each application 
has a title bar, a menu bar, and a number of toolbars. Figure 1 shows what Calc looks like 
when you first open it. 

One less common feature of the OOo interface is, by default, there’s a toolbar docked on 
the left side. In each case, it’s the main toolbar for the application, but the actual contents vary. 

Also different from many applications are two floating windows—the Stylist and the 
Navigator. Navigator is discussed later in this chapter; Stylist is covered in Chapter 5, 
“Making Life Easier with Templates and Styles.” 

How do I set things up the way I want them? 
OOo offers several ways to configure your working environment. Most settings are controlled 
by the Options dialog, available through the Tools menu (Tools | Options). This dialog (shown 
in Figure 2) is organized into sections. You move from section to section using the list at the 
left. Click a plus sign to expand a section and show all the items it contains. Click a minus sign 
to contract a section. 
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Figure 1. Like other modern applications, OpenOffice.org applications have a title bar, 
a menu bar, and plenty of toolbars. 

 
Figure 2. The Options dialog lets you configure OpenOffice.org your way. It contains 
a general section that applies to the product as a whole, and specific sections for  
each application. 
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Chapter 3, “OpenOffice.org File Storage,” discusses some of the items you can set. Others 
are discussed in this chapter. Chapters for the individual applications cover even more. 

You set up some items, such as customized menus and keyboard shortcuts, through the 
Configuration dialog accessible through the Tools menu (Tools | Configure, shown in Figure 
3). Those items are discussed later in this chapter. 

 
Figure 3. The Configuration dialog lets you customize menus, keyboard shortcuts, 
toolbars, and more. 

How do I make my configuration changes stick? 
Almost everything you change in the Options and Configuration should apply for that OOo 
session and all future sessions. The Basic Fonts page in the Text Document section of the 
Options dialog is an exception. It includes a check box allowing you to apply the specified 
fonts to only the current document. 

How do I set up custom keystrokes? 
Whether you have been using another office suite with numerous keyboard shortcuts or you 
just prefer the keyboard, you may find you would like to attach actions you perform often to 
key combinations in order to avoid using the menus or the mouse to access them. You do this 
on the Keyboard tab (shown in Figure 4) of the Configuration dialog. 
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Figure 4. The Keyboard page of the Configuration dialog lets you set up keyboard 
shortcuts to speed your work. 

The option buttons in the upper right corner of the Keyboard page determine whether you 
see keyboard shortcuts that apply throughout OpenOffice.org or only in the application you’re 
working with. 

There are very few shortcuts defined for OOo as a whole. Most correspond to commonly 
used shortcuts, such as Ctrl-A for Select All. If you have certain operations you want to 
perform in all (or several) of the applications, define them for OpenOffice.org. 

Far more shortcuts are predefined for each application. Some of them match the keyboard 
shortcuts in Microsoft Office. However, many familiar Office shortcuts are not built into OOo. 
Fortunately, you can create many of them. 

To create a new shortcut, highlight the character you want to use for the shortcut. (You 
can get to it quickly by clicking in the list of characters at the top of the dialog, and then typing 
the desired key combination.) In the lower half of the dialog, find the command to which you 
want to assign the keyboard shortcut. The list on the left shows menus and other major 
groupings. Find the right item there and the middle list shows the items from that menu or 
grouping. Select the item you want the shortcut to access. At this point, the rightmost list 
shows all the keystrokes already assigned to that item. Click Modify to assign the highlighted 
key combination. 
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Among the Microsoft Office applications, only Word allows you to set up 
keyboard shortcuts for menu items. (Excel allows shortcuts to be assigned to 
macros.) In OpenOffice.org, all the applications support custom keyboard 
shortcuts.  

 
That said, Word does go one better than OOo in this regard. In Word, you 
can assign a keyboard shortcut to all kinds of things, including styles, fonts, 
and even special symbols. OOo supports keyboard shortcuts only for 
commands and macros. (Of course, you could create a macro to assign a 
particular style or insert a particular symbol, and then assign a keyboard 
shortcut to that macro. See Chapter 18, “Macros and Automation.”) 

To remove a keyboard shortcut you defined, highlight the appropriate command, highlight 
that shortcut, and click Delete. 

How do I customize the toolbars? 
For a mouse lover, putting commonly used operations on the toolbars and organizing toolbars 
is incredibly useful. There are several ways to configure OOo’s toolbars; you can even create 
your own custom toolbars. 

The first issue is displaying toolbars. You determine which toolbars are displayed at any 
given time using the View | Toolbars menu item. Currently displayed toolbars are checked, 
while hidden toolbars are unchecked. 

Each of the built-in toolbars actually includes more items than it displays by default. You 
determine which items listed are displayed by right clicking on the toolbar and choosing 
Visible Buttons. Figure 5 shows the list for Writer’s main toolbar. You make an item visible 
by checking it in the list and hide it by clearing the checkmark. 



32  OOo Switch: 501 Things You Wanted to Know 

 
Figure 5. You turn toolbar items on and off using the Visible Buttons command on the 
shortcut menu for each toolbar. 

You can also add and remove items from the built-in toolbars. To add an item to a toolbar, 
use the Customize Toolbars dialog (Figure 6), accessible from the shortcut menu of any 
toolbar (choose “Customize”) or from the Toolbars page of the Configuration dialog (Tools | 
Configure on the menu). 
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Figure 6. To add an item to a toolbar,  choose the toolbar in the dropdown list and 
drag the item from the list on the left to the Buttons in use list on the right.. 

To add a command to a toolbar, find the command you want in the Available buttons list. 
Choose the toolbar you are customizing in the drop-down list. Now drag the command from 
the list into the Buttons in use list in the position you want. 

 
The technique for customizing a toolbar is quite different in earlier versions 
of OOo. In that case, you added a button to a toolbar by dragging it from the 
Customize Toolbars dialog to the appropriate toolbar. 

You can also use the Customize Toolbars dialog to associate an image with a command. 
Choose the command you’re interested in (by choosing a Toolbar that contains it from the 
Toolbars drop-down and looking in the Buttons in use list). Click the Icons button and choose 
the icon you want from the Customize Buttons dialog that appears. Be warned that this 
associates the icon with that command permanently, not just for that OOo session. It also 
affects all uses of the button, not just on that toolbar. (You can restore all button icons by 
clicking the Default button in the Customize Toolbars dialog. You reset a particular command 
to no icon by choosing the empty icon in the Customize Buttons dialog.) 

You can’t remove standard buttons, although you can hide them as described above. 
However, buttons you add can be removed in a couple of ways. To remove an individual 
button from a toolbar, use the Remove button in the Customize Toolbars dialog. To undo all 
your customizations from a toolbar (including buttons you have added, hidden or made 
visible), right-click the specific toolbar and choose Reset. 

How do I dock and move the tools? 
OpenOffice.org’s toolbars can either be docked to the edges of the application or float. 
Initially, all displayed toolbars are docked, but you can undock them. In addition, the Stylist 
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(see Chapter 5, “Making Life Easier with Templates and Styles”) and Navigator (described 
later in this chapter) can be docked. Toolbars and tools can be docked at the top, bottom, or on 
either side. 

To dock any toolbar or dockable tool, drag the title bar with the Ctrl key pressed. As you 
drag it to a border, you should see a shaded outline appear showing where the toolbar will be 
docked. When that happens, release the mouse button. 

To undock a tool or toolbar, use Ctrl-drag on any unused space on the toolbar (such as the 
divider bar between sections or unused space at the end of the toolbar) until you see the 
shaded outline of the undocked toolbar appear, or double-click it while holding down the Ctrl 
key. 

Once you dock a window once, you can re-dock at the same place using Ctrl-double click. 
(Actually, there’s a bug in OpenOffice.org 1.1 that causes toolbars to dock at the top when you 
use Ctrl-double click; it’s expected to be fixed in later versions.) 

Navigator and Stylist behave differently than toolbars in some ways. When you dock 
them, two small buttons appear at the border with the editing window. The upper or left-hand 
button (depending on where you docked) allows you to collapse the tool to minimize the area 
it occupies. 

The lower or right-hand button is a pushpin. It determines whether the document window 
shrinks to accommodate the docked tool or is partially covered by the tool. Figure 7 shows 
Calc with the Stylist docked on the right—the pushpin is up, so the Stylist partially covers the 
spreadsheet. Figure 8 shows the same set-up, except this time, the pushpin is down and the 
spreadsheet has adjusted. 

 
Figure 7. When you dock the Stylist or the Navigator, you can determine whether it 
covers the document window or the document window shrinks to make room. Here, 
the spreadsheet window is partially covered by the Stylist. 
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Figure 8. Pushing the pushpin on a docked tool tells the document window 
underneath to resize itself to accommodate the docked window. 

You can also resize the Stylist and the Navigator when they’re docked, changing the 
relative sizes of the tool and the document window. Actually, you can resize these windows 
when they’re not docked as well. However, the two sizes (docked and undocked) are 
independent. 

Why do some toolbar buttons have a little arrow? 
The OOo toolbars contain several buttons that open submenus or activate other toolbars. All of 
these buttons include a tiny blue-green arrow in the upper right corner of their icon. If the 
toolbar is docked horizontally, the arrow points down; if the toolbar is docked vertically or 
undocked, the arrow points to the right.  

If you click one of these buttons, releasing the mouse button immediately, it performs a 
default action. If you click and hold (“long click”), it opens the submenu or additional toolbar. 

For example, by default, the New button in the Function toolbar opens a new document of 
the type you’re currently working on. If you click and hold the button, it offers the same 
submenu as the File | New option on the menu. 

The buttons that open additional toolbars have several other behaviors. First, once you 
open such a toolbar, you can undock it by dragging it away from the button using its title bar. 
Figure 9 shows the Insert button from Writer’s Main toolbar, with its additional toolbar 
docked. Figure 10 shows the additional toolbar undocked. 

 
Figure 9. Some toolbar buttons display additional toolbars. 
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Figure 10. When you drag one of the additional toolbars away from its button,  
it undocks. 

When you use one of the items on an additional toolbar, the corresponding button changes 
to make that item its default. For example, in Figure 9, the default behavior of the Insert item 
is to add a table. If you use the button to open the Insert toolbar and then choose the Insert 
Special Character button, the default behavior for the Insert button changes to Insert Special 
Character. Its icon changes, as well, as shown in Figure 11. 

 
Figure 11. When you use one of the buttons from an additional toolbar, the triggering 
button changes its default behavior. 

The additional toolbars are accessible only through the related toolbar buttons. They’re not 
included in the list of toolbars accessed through View | Toolbars. 

What is the Navigator? 
The Navigator provides a structural overview of your document, as well as quick navigation 
within the document. It’s a first cousin to the Document Map feature of Microsoft Word. It’s 
available in all the OOo applications except Math. 

When you first start OpenOffice.org, the Navigator opens automatically. On subsequent 
uses, it remembers its last state. That is, if you left it open when you closed OOo, it opens the 
next time. If you left it closed, it doesn’t appear automatically. 

You open the Navigator by choosing Edit | Navigator from the menu or by pressing F5. 
There’s also a toggle button for it on the Function toolbar (it resembles the image of the 
compass on an ancient map). 

The appearance of the Navigator varies with the different OOo applications. For example, 
in Writer, it’s divided into a number of sections, such as Headings, Tables, and Graphics, with 
each section listing all the objects of that type in the current document. (In Figure 12, the 
Navigator shows the organization of the outline for this book.) For Impress, the Navigator lists 
each slide in the presentation and drills down to objects (such as pictures) on each slide. For 
Calc, there are sections for worksheets, ranges, graphics, and other objects, with each section 
listing all the objects of that type. 
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Figure 12. The Navigator shows the organization of a document. Use it to move 
quickly from one place to another. 

Regardless of what structure it shows, the Navigator offers a variety of ways to make 
editing a document easier. The simplest and most obvious is navigation within the document. 
Double-click any item in the navigator and your cursor is positioned on the item. 

However, the menu at the top of the Navigator offers a lot more options. The two 
navigation buttons move to the previous and next objects of a specified type. In Writer, Calc, 
and HTML Editor, you can shrink Navigator to show only the menu portion. (Click the first 
button in the second row. In Writer and HTML Editor, the button’s tool tip reads “List Box 
On/Off”; Calc uses the same icon, but the tool tip is “Contents.”) Figure 13 shows the reduced 
Navigator in Calc.  

 
Figure 13. A toggle button in Navigator lets you show only the menu portion, 
providing many navigation options in minimal space. 
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You can drag items from the Navigator into the document or another document. The  
result depends on the current Drag Mode (set using the button that looks like two links of a 
chain). By default, in most OOo applications, dragging an item from the Navigator creates a 
hyperlink to that item, which is the Insert as Hyperlink setting. The Drag mode button in the 
Navigator lets you change that behavior. Insert as Link makes a copy of the specified object, 
but links it to the original, so it can be updated later. Insert as Copy makes a copy of the 
specified object at the drop location. (Some of the applications, such as Draw, support only a 
subset of the choices.) 

What makes this tool particularly powerful is the document drop-down list at the bottom. 
You can switch it to point to another document, and then drag an object from that one into the 
document you’re editing. 

In some cases, you need to save the document before you can drag-and-drop items from it.  

How do I search and replace? 
Search and replace is one of the key functions of any document creation software. OOo’s 
search and replace functionality varies with the application (and is omitted in Math), but in all 
cases, offers a variety of options that make it possible to find almost anything. 

You start the process by choosing Edit | Find & Replace from the menu or pressing Ctrl-F. 
The Find & Replace dialog displays—which application you’re in determines its exact 
appearance. Figure 14 shows the dialog in Writer. 

 
Figure 14. The Find & Replace dialog lets you search for specified text and formatting 
and replace it with something else. 

Regardless of the application you’re in, much of the dialog is the same, including the 
Search for and Replace with textboxes, the Find, Find All, Replace, Replace All, Close, and 
Help buttons, and the Match case, Similarity, and Backwards check boxes. 

A few items in the dialog call for explanation. The meanings of Find, Replace, and 
Replace All are probably apparent, but Find All doesn’t make sense without an explanation. 
When you click Find All, every occurrence of the search string is located and highlighted. 
Whether this is useful for you depends on which module you’re in and how you use it. 
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In Writer and HTML Editor, you can search for formatting as well as for text. Use the 
Format button to open the Text Format dialog to specify font attributes; use the Attributes 
button to specify other kinds of formatting, such as paragraph information (things like 
alignment and Keep with next). You can apply the items in the Text Format dialog to both the 
search string and the replacement string. The string they apply to is determined by the position 
of the cursor prior to clicking the Format or Attributes button. 

Writer, HTML Editor, and Calc also allow you to search for styles. When you select the 
Search for Styles check box, the Search for and Replace with drop-down lists change to show 
the list of styles. The Search for list shows only those styles in use in the current document; the 
Replace with list shows all styles. 

If you have bad habits like transposing letters when you type, adding extra letters, or 
missing letters, take a look at Similarity search. When you select that check box, OOo looks 
not just for your search string, but for strings similar to the string you specify. Click the 
ellipsis (three dots) button to set the rules for similarity searches. 

How do I find paragraph breaks and tabs? 
Searching for punctuation like the end of a paragraph or a tab in a text document is common. 
In Writer, you do this by selecting the Regular expressions check box in the Find & Replace 
dialog. To find a tab, specify “\t” (without the quotes) as the search string. To find the end of a 
paragraph, specify “$” (without the quotes) as the search string. To find blank lines, use “^$” 
(without the quotes). 

 
Watch out. When you close the Find & Replace dialog and then open it 
again, the Regular expressions check box is no longer selected. 

Regular expressions are actually a very powerful mechanism that allows you to search for 
things based on complex patterns. If you need to find all strings that fit a particular structure, 
check out the topic “List of Regular Expressions” in the OOo Help file. 

Why does Undo stop undo-ing after a while? 
Edit | Undo (Ctrl-Z from the keyboard) is one of the most valuable tools in pretty much any 
program. It saves you from your mistakes by letting you back up. However, if you use Undo to 
back up a long way, you may find it stops and no more changes are undone. 

You can control the number of steps that can be undone using the Memory page in the 
OpenOffice.org section of the Options dialog (Tools | Options on the menu). The default is 20. 

How do I track changes? 
Revision marks are a powerful tool for editing documents, especially when several people are 
collaborating. They allow you to see what’s been changed, by whom, and when. 
OpenOffice.org supports revision marks in Writer and Calc. 



40  OOo Switch: 501 Things You Wanted to Know 

 

 Revision marks were a key tool in producing this book, as various editors 
marked up the original manuscript. We were able to share documents with 
revisions across platforms and even document formats. 

You turn on revision tracking by choosing Edit | Changes | Record from the menu. From 
that point on, every change to the document is marked. You control the appearance of marked 
changes using the Tools | Options dialog. To configure revision marks for Writer, use the Text 
Document | Changes section; for Calc, it’s Spreadsheet | Changes. 

As the mechanism for customizing implies, revisions have a different appearance in 
Writer than in Calc. In Writer, by default, a black line appears in the left margin for any line 
changed in the document. Deletions are stricken out, additions are underlined, and text with 
changed attributes (such as bold and italic) is bold. Changes by different authors appear in 
different colors. (OOo determines the author by looking at the user information, which is a 
good reason for specifying at least your name when you install OOo.) 

 
The vertical line indicating changes doesn’t appear in Online Layout view 
(View | Online Layout or Online Layout on the Main toolbar). 

In Calc, by default, revised cells have a thin colored border with a square in the upper left 
corner. Calc marks changes to contents, additions, deletions, and movement of data. Changes 
by different authors appear in different colors. 

In both cases, hovering the mouse pointer over a change displays a tool tip describing the 
change. Figure 15 shows a portion of a spreadsheet containing several changes, with the tool 
tip for one included. 

 
Figure 15. Holding the mouse pointer over a changed item displays a tool tip 
describing the change. 

Once some changes are marked, you have a variety of options for dealing with them. You 
can determine whether to display changes (Edit | Changes | Show) and you can accept or reject 
changes individually or as a group. To begin the process, choose Edit | Changes | Accept or 
Reject. The dialog in Figure 16 displays, allowing you to see the list of changes and decide 
which to keep, removing revision marks (accept), which to keep, leaving revision marks (do 
nothing), and which to undo (reject). 
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Figure 16. Use this dialog to determine what to do with marked changes. The Filter 
page lets you limit the list displayed. 

The Filter page of this dialog lets you limit the items shown on the List page. You can 
filter the list based on when changes were made, by whom, the type of change, or the comment 
associated with the change. Calc generates comments automatically, describing the actual 
change made. You add your own comments by highlighting the item you want to comment 
and choosing Edit | Changes | Comment from the menu. 

In Writer, you can turn revision marking on and off freely and your changes remain 
marked (although changes you make with revision marking turned off aren’t marked). In Calc, 
however, turning off revision marking accepts all marked changes. The message in Figure 17 
displays to let you decide whether to accept revisions and turn off revision marking. 

 
Figure 17. Calc displays this message when you turn off recording of changes without 
accepting or rejecting all changes first. Choose Yes to accept all remaining changes 
and turn off revision marking. 
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How do I compare documents? 
Document comparison is a first cousin to revision marking. It’s useful when someone has 
made changes to a document without recording the changes. 

 
Microsoft Excel doesn’t support comparison of spreadsheets. Calc does. 

To begin document comparison, open the newer version of the document or spreadsheet. 
Choose Edit | Compare Document from the menu. When the Insert dialog appears, choose the 
older version of the document or spreadsheet. 

After the comparison is complete, the Accept or Reject Changes dialog displays, showing 
all the differences between the two documents. Revision marks are added to the document to 
indicate the changes, as well. 

Why does what I type get changed? 
By default, OOo has a variety of automatic correction and formatting options turned on. These 
tools correct a variety of typing errors, as well as make your documents look more 
professional. However, sometimes these tools get in your way. 

The exact set of auto-correct and auto-format options varies with the application. Not 
surprisingly, Writer (and its alter-ego, HTML Editor) offer the most choices. However, a 
number of the options are the same across applications, and the applications share the 
underlying data. 

The most important thing about these tools is you can turn off any or all of them, and you 
can customize those you choose to keep. To modify the settings, choose Tools | AutoCorrect 
(or in Writer and HTML Editor, Tools | AutoCorrect/AutoFormat) from the menu. The 
AutoCorrect dialog opens; the exact appearance of the dialog varies with the application. 
Figure 18 shows the Options page of the Writer/HTML Editor version of the dialog, where 
you choose the features you want to use. (The Word Completion tab is present only in Writer 
and HTML Editor—Chapter 6, “Creating Simple Documents,” discusses that feature.) 
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Figure 18. Use the Options tab of the AutoCorrect dialog to turn the various features 
on and off. 

In Writer and HTML Editor, you can have two groups of settings, those that apply when 
you initially enter text (the “T” column) and those that apply when editing existing text (the 
“M” column). To apply changes while editing (the “M” column), you choose Format | 
AutoFormat | Apply. (This structure is analogous to Word’s AutoFormat as you Type and 
AutoFormat features.) 

There are too many configurable items to cover here, so I will look at just a few. 
However, the Help file explains the options reasonably well. Choose Help from the dialog 
itself to get to the right topic. 

The first item you’re likely to notice is automatic correction of typing mistakes. For 
example, if you type “withe” (one of my personal bugaboos), it automatically changes to 
“with”. The first item on the Options page, “Use Replacement Table” controls this feature. 
The Replace page of the dialog (shown in Figure 19) lets you configure the actual 
replacements. It comes with a substantial list of items, but you can remove or modify any of 
them that are inconvenient for you (for example, I prefer “withe” be replaced by “with the” 
rather than the default “with”) as well as add your own. Consider adding abbreviations  
for names and terms you type often. Be aware that it does not replace items inside of  
quotation marks. 
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Customizing the list of corrections can save you considerable time as  
you type. 

 
Figure 19. The Replace tab of the AutoCorrect dialog lists the substitutions that can 
be made automatically. 

 
You can immediately undo a particular replacement by choosing Edit | Undo 
from the menu or pressing Ctrl+Z as soon as the change is made. In Writer, 
HTML Editor, and Draw, a single Undo is sufficient; in Calc and Impress, it 
takes two uses of Undo to restore the original string. Also, in Calc, you can 
do this only if you’re still in the same cell. Once you leave the cell, Undo 
removes the new string. 

The second and third items, “Correct TWo INitial CApitals” and “Capitalize first letter  
of every sentence” are handy, catching two fairly common typing errors. However, there are 
places where each behavior is wrong. The Exceptions page of the dialog (shown in Figure  
20) lets you define exceptions to the rule for each. When the AutoInclude check box for  
each feature is selected, it adds words to the list automatically when you undo one of  
OOo’s changes.  
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Figure 20. The lists on the Exceptions tab let you override capitalization after a period 
and correction of two initial capitals. 

The Custom Quotes page of the dialog (Figure 21) controls the feature often known as 
“Smart Quotes.” Normally, the single and double quote keys on the keyboard insert straight 
quotes (" and ') when you type them. In many situations, curly quotes (“, ”, ‘, and ’) look 
better. The Replace check boxes determine whether to replace the straight quotes. 

 
In Microsoft Office, substitution of smart quotes can be either on or off. In 
OOo, you can determine what characters to substitute for straight quotation 
marks. Click the button showing one of the marks and a dialog displays    
showing symbols. Choose one to substitute for the quotation mark. 
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Figure 21. The Custom Quotes page lets you determine what characters, if any, to 
substitute for straight quotes. 

Other changes controlled by this dialog include turning pseudo-bold (text surrounded by 
asterisks) and pseudo-underlines (text surrounded by underscore marks) into the real thing, 
recognizing URL’s and turning them into hyperlinks, and much more. As you notice changes 
being made to your document, look at the AutoCorrect dialog to understand the change and 
decide whether to leave that particular feature on. 

Why does a “light bulb” window appear now and then? 
The light bulb window is the OOo Help Agent, designed to help you learn about 
OpenOffice.org. Whenever certain actions occur (such as changes due to your AutoCorrect 
settings), a little window (Figure 22) appears at the bottom right of your document. If you 
click the window, the Help file displays information about the operation that triggered it. This 
can be a handy learning tool as you’re getting accustomed to OOo. 
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Figure 22. This icon appears when OOo wants to tell you about some kind of change 
it made, or operation it performed. Click it to open Help at the appropriate topic. 

If you don’t click the light bulb, the window disappears after a bit. If you let it close three 
times in a row for the same operation, it will no longer appear for that operation. 

You can control the Help agent in several ways. First, you can turn it off entirely by 
clearing Help | Help Agent on the menu. You can also turn it off in the Tools | Options dialog 
on the General page of the OpenOffice.org section. That page also lets you specify how long 
the window remains open when you don’t click it. 

How do I check spelling and grammar? 
Like Microsoft Office, OOo offers spelling checks both as you work and after the fact. The 
Spellcheck item on the Tools menu controls these features.  

Choose AutoSpellcheck to turn on continuous spelling checks. When you do so, a check 
mark appears next to that item in the menu, and words that aren’t recognized display with a 
red squiggly line beneath. Right-click such a word to display a list of suggestions for 
correcting it. 

To check the spelling in an entire document or a selected portion, choose Tools | 
Spellcheck | Check from the menu or press F7. If any words aren’t recognized, the Spellcheck 
dialog (Figure 23) displays. Make the appropriate choice for each word found.  

 
Figure 23. The Spellcheck dialog lets you deal with words not recognized by the 
dictionary you’re using. 
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The Spelling engine uses a number of dictionaries specified in the Language Settings 
section of the Options dialog (Tools | Options). The Languages page of the section lets you 
specify the language you’re writing in, so it uses an appropriate dictionary . The Writing Aids 
page of that section provides lists of specialized terms; these lists include a variety of terms 
relevant to OOo, as well as those you indicate should be ignored through the Spellcheck 
dialog. (Note that the same information is available by clicking the Options button of the 
Spellcheck dialog.) Check the websites listed in the Appendix for additional lists. 

As installed, OOo includes a dictionary only for US English. However, you can download 
some additional language dictionaries from 
http://lingucomponent.openoffice.org/download_dictionary.html. You switch to an 
alternate dictionary by choosing Edit for the Available language modules section of the 
Writing Aids page. On the Edit Modules page that displays (Figure 24), choose the language 
for the dictionary you want to use. 

 
Figure 24. You specify the language to use for spelling checks, hyphenation rules, 
and thesaurus on the Edit Modules page, accessed through the Language Settings | 
Writing Aids page of the Options dialog. 

OOo doesn’t support grammar checking at this time. 

What is AutoPilot? 
AutoPilot is OOo’s answer to Microsoft’s Wizards, providing a guide through the initial 
construction of a document, as well as guidance for some other tasks. A number of OOo 
document types are supported. 

Help refers to each item in the AutoPilot menu as “an AutoPilot,” and I will follow that 
style. To use an AutoPilot, choose File | AutoPilot from the menu. The sub-menu (Figure 25) 
shows the available options. You can create a variety of documents, as well as convert some 
data from one format to another. 

Nicole McNeish
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Figure 25. Choosing File | AutoPilot from the menu offers these options for creating 
new documents and templates, or converting existing data. 

The AutoPilots provided perform a variety of tasks. The first group (letter, fax, agenda, 
memo) create both a new template and a new document based on that template. (See Chapter 
5, “Making Life Easier with Templates and Styles,” for an explanation of using templates.) 
The Presentation AutoPilot creates a new presentation, possibly based on a template, or opens 
an existing presentation. (By default, this AutoPilot runs automatically each time you open 
Impress. You turn that setting off in the Tools | Options dialog.) 

The Web Page AutoPilot creates a new HTML document based on a template and a layout 
style. The Form AutoPilot sets up a Writer document as a form, using specified data. The 
Report AutoPilot lets you create reports based on data in a database. 

The Document Converter provides bulk conversion of StarOffice and Microsoft Office 
documents to OpenOffice.org format. The Euro Converter converts currency in Calc 
spreadsheets into Euros. 

The last two AutoPilots make data available in a format OOo can work with. In fact, the 
Address Data Source AutoPilot opens automatically the first time you use OOo. 

The exact steps and options involved vary with the AutoPilot. It’s worth spending some 
time experimenting to see what each can do for you. 

What is the Gallery? 
The Gallery is a tool for organizing graphics to make them easily accessible. To open it, 
choose Tools | Gallery from the menu. This menu item is a toggle, so choose the same item 
again to close the Gallery. 

The Gallery is dockable. By default, it’s docked beneath the Function toolbar. Like the 
Stylist and Navigator, it includes buttons to let you collapse it and to have the document adjust 
to it. 

The Gallery (Figure 26) is organized into themes (categories). Each theme contains 
graphics from a directory tree (specified when creating the theme). You can filter on the type 
of graphic image. OOo provides a number of themes, and you can add your own. You can also 
download themes from http://www.ooextras.org or http://documentation.openoffice.org. 

http://www.ooextras.org
http://.documentation.openoffice.org
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Figure 26. The Gallery holds graphic images organized into categories called themes. 

To add a theme, click the New Theme button. The Theme Properties dialog (Figure 27) 
displays. Specify a name for the theme, and then switch to the Files tab (Figure 28), where 
you choose the files to add to this theme. First, specify the type of graphic image to include in 
this theme. The default “<All Files>” includes all types of graphic images. Click the Find Files 
button to specify a directory tree to search. All the graphics of the specified type in the 
directory and its subdirectories are listed. Either click Add All to put them all in this theme or 
choose the ones you want to include and click Add. 

 
Figure 27. The Theme Properties dialog displays when you add a new theme. 
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Figure 28. Use the Files tab of the dialog to specify the graphics to include in the  
new theme. 

You can drag items from the Gallery into documents to add that graphic image to the 
document. For more information on adding graphics to documents, see the chapters for the 
individual applications. 

The Gallery can also hold sounds in a couple of formats. As with graphics, you can drag 
the sound items to a document if the document supports sound. 

Summary 
Quite a few things work the same way or similarly across multiple OpenOffice.org 
applications. Learning how to use one of the applications is likely to make using the  
others easier. 

There are two more major features shared by the bulk of the OOo applications: templates 
and styles. The next chapter explains what they are and how to use them. 

 

 
 
 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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Chapter 5 
Making Life Easier with 

Templates and Styles 
For most users, uniformity within and across documents is important. OpenOffice.org 
supports this need with styles that define a group of formatting characteristics and 
templates that combine styles with boilerplate text to form the basis for new documents. 

Seasoned Microsoft Office users may be familiar with both templates and styles; in Office, 
they’re a key to increased productivity. However, many Office users never touch them. In 
OOo, styles and templates are even more important than in Office, and wise users will become 
familiar with both the concepts and the details of using them. 

What is a style? 
A style is a group of formatting characteristics gathered together and given a name. Styles 
offer a number of advantages. First, they make it easy to apply the same formatting to different 
parts of a document; just use the same style. Second, they make it easy to change formatting 
uniformly; change the formatting of the style and everything using that style changes. Finally, 
because you can save styles in templates (discussed later in this chapter), it’s easy to use the 
same formatting across a whole family of documents. 

For example, you may decide to write a document using 10-point Arial for the text and 
14-point Arial for headings. If you later decide to change to Times New Roman, with styles, 
you make the change in two places—the definitions of your body text and heading styles. 
Without styles, you have to go through and change each paragraph. 

OpenOffice.org offers a variety of style types, varying with the application. Table 1 
shows the types of styles available in the various applications. 

Table 1. Different types of styles apply to different objects. Each application offers a 
variety of style types. 

Type of style Applies to Used in 
Cell Individual cells Calc 
Character Blocks of text Writer, HTML Editor 
Frame Inserted objects Writer 
Graphics Drawn objects Impress, Draw 
Numbering Bulleted and numbered lists Writer, HTML Editor 
Page Entire pages Writer, Calc 
Paragraph Paragraphs Writer, HTML Editor 
Presentation Components of a presentation Impress 

 
Depending on the type of style and the application, a style’s definition may include such 

things as font characteristics, paragraph formatting, tab definitions, colors, text wrapping, page 
size, margins, borders, columns, bullets and numbering, alignment, and more. In other words, 
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pretty much every kind of formatting can be applied to some type of style. (The chapters that 
cover the individual OOo applications explore many of the items that go into styles.) 

OOo includes a large number of predefined styles, usable as is. You can modify the 
predefined styles to fit your needs. OOo also offers the ability to define new styles of the 
various types and use them. Defining custom styles is discussed later in this chapter. 

For a number of the style types, there’s a style named Default. This is the style used for 
objects of that type if you don’t specify a different style. To change the overall appearance of a 
document, modify the Default style. (See “How do I change the existing styles and create new 
styles?” later in this chapter.) 

What is the Stylist? 
The name “Stylist” is a contraction of “style” and “list,” no doubt chosen because of the 
implications of the word “stylist.” The Stylist is available in every OOo application  
except Math. 

Open the Stylist by choosing Format | Stylist from the menu, clicking the Stylist button on 
the Function toolbar, or pressing F11. (All of these actually toggle the Stylist on and off.) The 
Stylist can be docked. See “How do I dock the tools?” in Chapter 4, “The OpenOffice.org 
Interface,” for details. 

The Stylist provides easy access to all available styles, offering options for organizing 
them, as well as for defining new styles. Figure 1 shows the Stylist in Writer, where it has the 
most options. 

 
Figure 1. The Stylist shows defined styles of each type and allows you to apply them, 
as well as define new styles. 
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The left section of the button bar at the top of the Stylist shows the different types of 
styles available in the application (from the list in Table 1). In Writer, five types of styles are 
available (paragraph, character, frame, page, and numbering), so there are five option buttons 
in Figure 1. (The buttons have tooltips to identify the style types.) 

The main section of the Stylist is a list of styles of the chosen type. In Figure 1, the list 
shows paragraph styles. The dropdown list beneath the list of styles lets you limit the list to a 
particular subset. In addition to “Automatic” shown in Figure 1, the drop-down list includes 
options such as “All Styles” to show everything of that type, “Applied Styles” to show only 
those styles in use in the current document, “Custom Styles” to show only user-defined styles, 
and a variety of others. The items in this drop-down list vary with the application and with the 
type of Style currently chosen in the button bar. 

The buttons on the right end of the button bar provide easy ways to change formatting; 
they’re discussed later in this chapter.  

How do I use the styles provided? 
There are several ways to apply styles to text and objects, with some variation from 
application to application. For text, you can generally apply styles either before or after typing. 
For other kinds of objects (such as graphics and drawings), it’s easier to add the object, and 
then set its style. 

You set the style using the Stylist. In Writer, HTML Editor, and Calc, make sure the 
cursor is positioned where you want the new style, double-click the desired style in the Stylist, 
and then begin typing. In Writer and HTML Editor, the Text Object toolbar also contains a 
drop-down list showing all the styles already in use in the current document. You can choose a 
style from the list (shown in Figure 2). Unfortunately, there’s no keyboard shortcut to get to 
the drop-down list quickly as in Microsoft Word. (See “How do I apply a style using the 
keyboard?” later in this chapter for an alternative.) 

 
Figure 2. The styles drop-down list in the Text Object toolbar includes all the styles in 
use in the document. 

The Format menu provides another way to get to the list of styles. Choose Format | Styles 
| Catalog to open the Style Catalog dialog (Figure 3). Choose a style from the catalog to apply 
at the insertion point. 
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Figure 3. The Style Catalog provides a third way to access the list of styles. 

You can also change the style once you enter text. Highlight the text or cells you want to 
change and choose the desired style from the Stylist, styles drop-down list, or Style Catalog.  

When working with objects other than text, and in Draw, you apply styles by selecting  
the object and then choosing the appropriate style from the Stylist, drop-down list, or  
Style Catalog. 

You can quickly change the style of multiple items using the Stylist. The paint can icon on 
the right side of the button bar controls “Fill Format Mode”—choose a style, click this button, 
and then, depending on the application, either select all the objects you want to apply the 
specified style to or click the objects to be changed. When you’re done, click the button again 
to turn off this mode. 

How do I apply a style using the keyboard? 
Microsoft Word power users may be accustomed to changing styles using only keystrokes. 
Word provides a keyboard shortcut (Ctrl-Shift-S) to jump to the Styles list in the toolbar, and 
allows you to assign keyboard shortcuts to individual styles. 

It’s not as easy in OOo. There’s no keyboard shortcut for the Styles drop-down list, and 
the Stylist’s shortcut turns it on and off, but doesn’t land focus there; at a minimum, you have 
to click in the Stylist before you can use the keyboard there. In addition, you can’t assign 
keyboard shortcuts to styles. 

However, all is not lost. You can assign a shortcut to the Style Catalog. (See “How do I 
set up custom keystrokes?” in Chapter 4, “The OpenOffice.org Interface.” The command you 
want is Templates | Style Catalog.) Once you open the Style Catalog, you can navigate solely 
with the keyboard. 

You can also create a macro that applies a particular style to a paragraph or other 
selection, and then assign a keystroke to that macro. See Chapter 18, “Forms, Macros and 
Automation,” for details. 
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How do I change the existing styles and create  
new styles? 
There are several ways to create and edit styles. You can do so directly, defining exactly  
what you want or you can tell OOo to create or change a style based on formatting in  
your document. 

Editing styles directly 
To edit an existing style directly, select it in the Stylist or the Style Catalog, right-click, and 
choose Modify. (In the Style Catalog, you can click the Modify button, instead.) A dialog 
displays showing the definition for that style. The exact appearance of the dialog varies with 
the type of style. Figure 4 shows the Paragraph Style dialog. 

 
Figure 4. The dialog that appears to edit a style varies with the style type. This dialog 
is for editing paragraph styles. 

Most of the items in the dialog are analogous to things you can change directly through 
the Format menu. That makes sense because styles encapsulate formatting choices. 

Change whatever aspects of the style you want, and then click OK to save the modified 
style. The changes you make here apply only within the current document. To affect styles 
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across documents, you need to change the style definitions in a template. (See “What is a 
template?” later in this chapter.) 

Creating new styles directly 
Creating a new style isn’t much different than editing an existing style. Right-click in the 
Stylist or Style Catalog and choose New or, in the Style Catalog, click the New button. The 
Style dialog appears as when you modify a style, but the Organizer page is different. In this 
case, the Name field shows “Untitled1,” as does the Next Style drop-down list, if it’s present. 

For many of the style types, every style (except the Default style) is based on another style 
and inherits its characteristics from that style. The Linked With drop-down list indicates which 
style a style is based on. When you create a new style, it’s automatically set to inherit from the 
style selected when you chose New, but you can change that if you wish. (It’s actually easiest 
to first click the style you want to base the new style on, and then choose New.) The important 
thing to keep in mind is that a style has all the characteristics of the style it’s linked to, except 
those you change explicitly. If you modify a style, any styles linked to it are modified as well. 

Assign a name to the style. If the new style should always be followed by a different style, 
choose the appropriate style in the Next Style drop-down list, if it’s available. For example, in 
this book, heading styles are always followed by a paragraph using a style called “_first 
paragraph,” which isn’t indented. Paragraphs using “_first paragraph” are always followed by 
an indented paragraph that uses a style called “_body text.” Setting the next paragraph style  
as part of the style definition ensures that when you hit Enter at the end of a paragraph, the 
next paragraph is already set to the appropriate style. (This works the same way in  
Microsoft Word.)  

The Organizer page also lets you choose the category where the new style belongs. That 
choice affects both the Stylist and the Style Catalog. 

Once you set all this up, use the remaining pages of the dialog to set up the formatting of 
the new style exactly as you want it. When you finish, click OK. 

Using the Stylist to create and edit styles 
The Stylist offers shortcuts for creating and editing styles. 

The middle button on the right side of the Stylist’s button bar (with a tooltip of “New 
Style from Selection”) lets you define new styles on the fly. Highlight some text or choose an 
object, and then click the button. The Create Style dialog (Figure 5) appears. Type a name, 
and then hit OK to save the new style, based on the formatting of the selected item. 
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Figure 5. This dialog displays when you create a new style based on a  
selected object. 

The rightmost button on the button bar (with a tooltip of “Update Style”) lets you change 
the definition of a style. Select some text or an object, and then click Update Style. The 
definition of the style the selected text or object is based on updates to match the current 
formatting of that item. For example, suppose you use the style “Heading 1” for all the 
headings in a document, and then you decide to make them dark blue instead of the default 
black. Change the color of one of the headings, highlight the heading, and click Update Style 
in the Stylist. That changes the definition for Heading 1, which affects all the uses of Heading 
1 already in the document, as well as those you add afterward. 

As with modified styles, new styles apply only to the current document. You need to 
define styles in a template to make them available to multiple documents. 

What is a template? 
A template is a model for a document. It contains basic structure, styles, and macros. 
Templates make it easy to create multiple documents with the same structure and format. 

Every document you create in OpenOffice.org is based on a template. If you don’t specify 
one, it uses the default template for that application. (By analogy, Microsoft Word bases new 
documents on the Normal.DOT template, if you don’t specify otherwise.) The default template 
is normally an empty document of the appropriate type. (See “How do I change the template 
used for new documents?” later in this chapter for more on the default template.) 

You can download a variety of templates from 
http://documentation.openoffice.org/Samples_Templates/index.html. The templates 
available provide the framework for such things as a balance sheet (Calc), an invoice (Writer), 
flowcharts (Draw), and more. There are also templates available at 
http://ooextras.sourceforge.net/. 

How do I use a template? 
To create a document based on a particular template, choose File | New | Templates and 
Documents from the menu in an OOo application, or choose From Template in the 
QuickStarter. The Template and Documents dialog (Figure 6) displays. Double-click a folder 
to open it and see the templates within. Choose the template you want and click OK to create a 
new document based on that template. (See “Where does OpenOffice.org store my files?” in 
Chapter 3, “OpenOffice.org File Storage,” for an explanation of where templates are stored.) 

http://documentation.openoffice.org/Samples_Templates/index.html
http://ooextras.sourceforge.net/
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Figure 6. Choose a template from this dialog to create a new document based on  
the template. 

You can also create a new Impress presentation based on a template by choosing  
File | AutoPilot | Presentation. In fact, by default, the Presentation AutoPilot runs when you 
open Impress, so you can always start an Impress session by creating a new presentation  
from a template. 

The various AutoPilots for Writer documents work by creating a new template, and then 
creating a document based on that template. Once you run a particular AutoPilot once, you 
may find it easier to simply use the template for future documents of that type. 

When it comes to applying a template to an existing application, OOo differs from 
Microsoft Office. In most Office applications, you can open an existing document and apply a 
different template to it to change its appearance. OOo doesn’t support this behavior. To 
change the template for an existing document, you need to create a new document based on 
the desired template, and then either cut and paste the contents of the original document into 
the new document, or in those applications that offer it, use Insert | File to put the original 
contents into the new document. 

Can I use Office templates? 
Yes and no. Templates created in Office don’t show up in the Templates and Documents 
dialog. However, you can double-click a template in the Open dialog (File | Open) or in a tool 
like Windows Explorer and a new document is created based on that template. 

To use this solution, you have to know where the template is located. If you don’t already 
know, the easiest solution is to search for the appropriate extension (DOT for Word templates, 
XLT for Excel templates, POT for PowerPoint templates). Once you find the template, if you 
made OOo the default application for Word files, simply double-click the file name to create a 
new file based on the template. If not, use Open With from the file’s shortcut menu and choose 
OOo from the list. 
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How do I create a new template? 
Creating templates isn’t much harder than creating documents. First, create a new document in 
the appropriate application. Create and modify the styles you want for the template. Add any 
boilerplate text or objects you want in the template. (For example, if you’re creating letterhead 
for a company, you might add a header with the company name and address, and set the 
company’s logo as a watermark.) Make sure to position the cursor where you want it to appear 
when you create a new document based on the template. 

When the document looks exactly as you want your template to appear, choose File | 
Templates | Save from the menu. (Note that this works differently from Microsoft Office, 
where you use File | Save As and choose template as the type of file.) The Templates dialog 
(Figure 7) displays. Type a name for the new template, and choose a category in which to 
store it. This list of categories here is the same as in the Templates and Documents dialog. 

 
Figure 7. This dialog lets you save a new template. Choose a category on the left to 
keep your templates organized. 

How do I change the template used for new documents? 
When you choose File | New and pick a document type, or click the New button on the 
Function toolbar, or create a new document using QuickStarter, OOo bases the new document 
on the default template for the specified application. This is analogous to Microsoft Word’s 
behavior where new documents are based on the Normal.DOT template unless you choose 
another. However, unlike Word, OOo doesn’t make the default templates available as files  
you can edit. So, changing the default template isn’t as easy as opening the right file and 
modifying it. 

If you want to make changes that carry over to all new documents of a particular type, you 
need to create a template with the desired settings, and then make that template the default. 
Create the template as you would any other (see the previous section, “How do I create a new 
template?”). Once you save the new template, make it the default for the appropriate 
application using the Template Management dialog (Figure 8). You open this dialog by 
clicking the Organizer button on the Templates dialog (File | Templates | Save, shown in 
Figure 7), the Organize button on the Templates and Documents dialog (File | New |Templates 
and Documents), or by choosing File | Templates | Organize from the menu. 
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Figure 8. The Template Management dialog lets you set up default templates and 
much more. 

In the left column, navigate to the template you want to make the default. (Double-click a 
folder to expand it and show the templates within.) With the desired template highlighted in 
the left column, open the Commands list and choose Set as Default Template. From that point 
on, all new documents of the appropriate type created without specifying a template are based 
on the template you set as the default. 

If you want to return to the built-in default, open the Commands list and choose Reset 
Default Template. Choose the appropriate file type from the list. 

How do I open a template for editing? 
To open a template so you can make changes to it, choose File | Templates | Edit from the 
menu, and then choose the template you want to edit. Make whatever changes you need to the 
boilerplate text, the styles, or the macros, and then save it as you would any other document. 

You can also open a template, modify it, and save the modified template as a new 
template. In that case, when you’re done editing, use File | Templates | Save to give the 
modified template a new name. 

How do I manage templates and styles? 
The Template Management dialog (File | Templates | Organize on the menu) provides a lot 
more options than just setting default templates. For example, it lets you move styles between 
templates and documents and move templates from one folder to another. 

Each of the lists in the dialog shows either templates OOo knows about or the list of  
open documents. You can work with the items in those lists to move both templates and  
styles around. 

Copying styles 
Sometimes, you have a style in one template you want to make available in another. To do so, 
find the template that contains the style in one list. Double-click the template name and a 
Styles item appears. Double-click the Styles item and a list of styles displays. 
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In the other list, find the template to which you want to copy the style. Again, double-
click the template name to show the Styles item; double-click the Styles item to display the list  
of styles. 

Now, you can drag (to move) or Ctrl-drag (to copy) a style from one template to the other. 
If the target template or document already has a style by that name, you’re prompted about 
overwriting it.  

Moving templates 
The dialog also lets you move templates from one folder to another. Set both lists up to show 
folders, and then drag the template from one list to a folder in the other list. 

The New button in the Commands drop-down list lets you add a folder for templates. 
Focus must be on a list of templates for New to be enabled. When you click it, it adds a folder 
called “Untitled”. Type the name for the new folder. 

The dialog offers a variety of other options, including the ability to print a list of the styles 
in a template or document with their descriptions. 

Summary 
Investing some time developing your own styles and templates will pay off in both the short 
run and the long run. As you create documents, having appropriate styles defined minimizes 
the amount of time you spend on formatting. Instead of needing to set a variety of options, you 
can just choose the right style and keep going. Over the long haul, templates and styles 
provide uniformity both within and across documents, making your work look more 
professional and making it easier to apply global changes. 

 

 
 
 
 
 
 
 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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Chapter 6 
Creating Simple Documents 

Most of the documents you need to write aren’t complicated, but do require some 
formatting and other features. This chapter looks at straightforward document creation 
with Writer. 

Most people write just a few kinds of documents, letters, memos, reports, and so forth. You 
don’t have to learn all the features of Writer to produce basic documents that look good. 

How do I start Writer? 
You can open Writer in a number of different ways. If QuickStarter is running, right-click  
it and choose Text Document to open Writer with a new blank document. Choose Open  
File from QuickStarter and pick an existing Writer or Word document to open Writer with  
that document loaded. A third choice with QuickStarter is to choose From Template, and  
then choose a Writer template; that opens Writer with a new document based on the  
chosen template. 

If you have another OpenOffice.org application open, choose File | New | Text Document 
or long click (see “Why do some toolbar buttons have a little arrow?” in Chapter 4, “The 
OpenOffice.org Interface”) on the New button on the Function toolbar and choose Text 
Document to open Writer with a blank document. Choose File | Open or the Open button to 
open Writer with an existing document. 

Finally, depending on your operating system, you may be able to open Writer from  
a menu. In Windows, choose Start | Programs | OpenOffice.org <version> | OpenOffice.org 
Writer. 

What do I see when I first open Writer? 
The first time you open Writer, the Stylist will probably be open; the Navigator may be open, 
as well. (See Chapter 5, “Making Life Easier with Templates and Styles” for details on the 
Stylist and Chapter 4, “The OpenOffice.org Interface” for information about the Navigator.) 
The document is zoomed to fill the entire width onto your screen.  

Figure 1 shows the initial layout of Writer. 
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Figure 1. When you first open Writer, the full width of your document shows and the 
Stylist and Navigator are open. 

Three toolbars are docked by default. Right underneath the menu is the Function toolbar, 
which includes buttons for opening, saving and printing documents, cutting, copying and 
pasting, undoing and redoing, plus a few others. Beneath that toolbar is the Text Object 
toolbar. This one includes controls to set the style and font of text, as well as to control text 
alignment, and a variety of other items. The Main toolbar is docked at the left, by default. It 
includes buttons for inserting tables, graphics, and other items, for checking spelling, and to 
turn on and off the displaying of non-printing characters (paragraph marks, spaces, and so 
forth), as well as other items. (See Chapter 4, “The OpenOffice.org Interface,” to learn how to 
move the toolbars around.) 
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How do I control the way my document fills the window? 
Writer gives you choices about how your document displays in the Writer window. The 
default behavior varies with the version of OOo you’re using. 

To have the document fill the horizontal space and show as much of a page vertically as 
possible (the default in OOo 1.1), choose View | Zoom from the menu and then choose 
Optimal from the Zoom dialog that appears. You can experiment with the dialog to find the 
setting that works best for you. 

The status bar at the bottom of the Writer window shows the current setting. (In Figure 1, 
it shows 118%.) Click the value for a list of choices to change the view. 

In Microsoft Word, you have several options for how to view a document. Writer also 
offers a couple of options, but they don’t map exactly to Word’s options (and, in one case, 
Word has more functionality). 

Writer’s default view corresponds, more or less, to Word’s Page Layout view. You see 
page breaks, and headers and footers are always visible. Online Layout view (View | Online 
Layout from the menu or the Online Layout button on the Main toolbar) corresponds to 
Word’s Web Layout view. No page breaks are shown, and in fact, pages are considered 
somewhat irrelevant. Online Layout is a toggle, so to switch back to the default view, choose 
View | Online Layout again. 

Unfortunately, Writer doesn’t offer a view analogous to Word’s normal view, which 
doesn’t show page breaks, but does include page information in the status bar. 

How do I create new documents? 
As described in “How do I start Writer?” earlier in this chapter, you can create a new 
document in several ways when you open Writer. The same techniques work to create another 
new document once you’re working in Writer. 

How do I set default fonts? 
Writer defaults to using particular fonts for documents. You can change that setting to provide 
your own defaults using the Basic Fonts (Western) page in the Writer section of the Options 
dialog (Tools | Options on the menu, and then expand the Text Document item). Figure 2 
shows this page. 

The Basic fonts page is one of the few places where the Options dialog lets you set things 
for a single document rather than across the application or the entire suite. If you select 
Current document only, the fonts you choose apply only to the document you’re currently 
editing, not to any others you have open or create later. Use the Default button to reset to the 
original fonts. 

Also, keep in mind that the best way to choose the fonts in a document is by setting styles 
to the fonts you want. See Chapter 5, “Making Life Easier with Templates and Styles,” to 
learn how to use and define styles. 
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Figure 2. You choose the fonts you want to work with by default in the Options  
dialog. Select Current document only to change fonts only in the document you’re 
working on now. 

 
Even when you’re using custom styles, changing the Default style (the first 
drop-down list) in the Basic Fonts page may change the font of the text in 
your document. 

How do I make the ruler available? 
Like Word, Writer offers a ruler to show you where things are on the page. However, when 
you try to turn it on using View | Ruler, you may find the menu option disabled. To make the 
ruler available, you have to turn it on on the View page of the Text Document section of the 
Options dialog (Tools | Options).  

To make the Ruler available, select the Ruler check box; once it is selected, separate 
check boxes for the Horizontal ruler and Vertical ruler are available. Select one or both of 
those. Clicking OK at this point makes the ruler available and displays it. If you want to enable 
the Ruler item on the menu without displaying the Ruler, clear the Ruler check box, but leave 
the Horizontal ruler and Vertical ruler check boxes selected. 

Once you enable the Ruler, you turn it on and off using View | Ruler. Be aware, though, if 
you have several documents open, only the one you’re editing when you enable the Ruler can 
use it at that time. Documents you create or open from that point on have access to the ruler. 

What the heck is the ruler measuring? 
By default, OOo uses inches. If you’re in a country that uses the metric system, the first time 
you turn the Ruler on, you may be very surprised. Fortunately, you can determine what units 
Writer uses, not just for the Ruler, but in its dialogs as well. 

To set the measurement units, open the Options dialog (Tools | Options) and choose the 
General page of the Text Document section. The Measurement unit drop-down list in the 
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Settings section lets you specify millimeters, centimeters, inches, picas, and points. The last 
two are units familiar in the printing and publishing world, but much less well known to the 
rest of the world. 

What’s with the text that appears when I’m typing? 
You’re likely to find Writer’s word completion feature either incredibly helpful or very 
annoying; I suspect few people are neutral on this one. Word completion pays attention to 
what you type and offers to finish the word for you. Word completion learns as you write, so 
the list of words it can complete grows constantly (though the total list size is limited). 

Word completion is controlled by the Word Completion tab (Figure 3) of the 
AutoCorrect dialog (Tools | AutoCorrect/AutoFormat on the menu). To turn word completion 
off, clear the Enable word completion check box. If you want to use the feature, but prefer it 
not learn as you go, clear the Collect words check box. 

The item you’re most likely to change in this dialog is the Accept with drop-down list. 
When Writer makes a suggestion, you have to actively accept it to keep the word in the 
document. By default, pressing Enter accepts the suggestion. However, you can change the 
AutoCorrect mechanism to use the End key, the right arrow, or the spacebar, instead. 

The Min. word length spinner lets you determine what size words are recognized. By 
default, only words of five or more letters appear on the list. 

If you find having the suggested word appear on your typed line distracting, try selecting 
the Show as tip check box. This makes the suggestion appear as a tooltip (the approach used in 
Microsoft Word). 

Select Append space to tell Writer to add a space at the end of the word when you accept 
a suggestion. This feature is smart enough to add the space only if you don’t add a space or 
other punctuation yourself. However, when Append space is cleared, you can accept a 
suggestion and then add additional characters to the word manually. For example, if you type 
“abb,” word completion offers “abbreviate” as a suggestion. If you accept that suggestion, 
with Append space cleared, you can then add a “d” to form “abbreviated,” an “s” to make 
“abbreviates,” or whatever change you need. 
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Figure 3. This tab of the AutoCorrect dialog controls word completion. You can 
choose the character that accepts the suggestion, manage the list of suggestions, or 
even turn the feature off altogether. 

How do I format my text? 
This is a big question, but the best answer is brief: Use styles. For both consistency and ease of 
editing, it’s far better to apply an appropriate style to a paragraph, a block of text, or pretty 
much anything else than to format each separately. 

However, saying that styles are the answer requires the follow-up question: How do I  
set up the formatting for my styles? The answer to both questions is similar, though the 
particulars vary. 

Formatting covers quite a lot of territory. Fortunately, Writer’s menu system makes it easy 
to look at the options. When formatting directly, you can approach things on a character basis, 
a paragraph basis, or a page basis. The Format menu contains options for each. A number of 
the most common formatting options (such as bold, italic, underlines, and paragraph 
alignment) are included on the Text Object toolbar, as well. 
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Formatting characters 
Choose Format | Character from the menu to open the Character dialog (Figure 4). It contains 
choices that affect individual characters and blocks of text, primarily font-related. If text is 
selected (highlighted) when you open this dialog, the changes you make affect the selected 
text. If no text is selected, the choices you make affect what you type once you close the 
dialog. The new formatting remains in effect until you change it or turn it off. (See “How do I 
turn off character formatting?” later in this chapter.) 

 
Figure 4. The Character dialog lets you change the formatting of individual characters 
and blocks of text. 

Formatting paragraphs 
Not surprisingly, you format paragraphs by choosing Format | Paragraph from the menu, 
which opens the Paragraph dialog (Figure 5). The dialog offers control over a variety of 
items, including indentation, tabs, and hyphenation. There’s a key difference between 
character formatting and paragraph formatting. Changes you make in the Paragraph dialog 
affect whatever paragraph the cursor is in, whether that paragraph is highlighted or not. 
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Figure 5. The Paragraph dialog controls indentation, text alignment, hyphenation, 
borders, and more. 

Formatting pages 
Page formatting is different from character or paragraph formatting; it works only with  
page styles, not with individual pages. When you choose Format | Page from the menu, the 
Page Style dialog (Figure 6) opens, showing the formatting for the style used on the current  
page. Any changes you make affect not just that page, but also the style itself. (For an 
explanation of styles and how to create them, see Chapter 5, “Making Life Easier with 
Templates and Styles.”) 
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Figure 6. You can’t format individual pages, only page styles. 

The Page Style dialog controls the paper size and type, margins, the presence and size of 
headers and footers, and more. In order to have pages in a single document use different 
margins or have different headers or footers, you must use different page styles. This is in 
contrast to Microsoft Word where you handle that kind of change with a new section. 

Formatting styles 
Setting the format for a style isn’t much different than setting the format for a block of text or 
a paragraph. Highlight the style in the Stylist or Style Catalog (see Chapter 5, “Making Life 
Easier with Styles and Templates”) and choose Modify from the context menu. The Style 
dialog opens, showing the appropriate choices for that style. 

Paragraph styles have a lot more options than character styles, and in fact, include many 
of the character style options, such as font settings. 

Some specific formatting options are discussed in the sections that follow. 

How do I create subscripts and superscripts? 
Subscripts and superscripts are character formatting. You set them on the Position tab (Figure 
7) of the Character dialog (Format | Character from the menu). As with other character 
formatting, you can change highlighted text into a subscript or superscript or you can turn the 
feature on first and then type the text that should become a subscript or superscript. 
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Figure 7. This tab of the Character dialog lets you create subscripts and superscripts 
as well as rotating text. 

 
In Writer, you can specify how far above or below the baseline a subscript or 
superscript appears. Word doesn’t include this option. 

There are predefined keyboard shortcuts for subscripts (Ctrl-Shift-B) and superscripts 
(Ctrl-Shift-P). 

How do I turn off character formatting? 
If you turn on formatting like bold, italics, subscript, or superscript with no text selected, it 
applies to everything you type from that point on. Eventually, you probably want to return to 
normal text. To do so, choose Format | Default from the menu. You can use the same menu 
item to return highlighted text to the normal formatting for the paragraph style. The menu item 
removes any character style you may have applied and any inline formatting. 

In Word, the Ctrl-Spacebar combination is assigned to this task. Be careful—in Writer, 
that keystroke inserts a non-breaking space. You may want to redefine it to restore normal 
formatting; see Chapter 4, “The OpenOffice.org Interface,” to learn how. (The item to use for 
this is Format | Reset Font Attributes.) 



Chapter 6: Creating Simple Documents  77 

How do I set up indentation? 
Indentation is paragraph formatting, and choices you make here affect entire paragraphs, 
although you can handle the first line differently than the rest of the paragraph. You can indent 
a paragraph from the left margin or the right margin. 

Set indentation using the Indents and Spacing tab (Figure 8) of the Paragraph dialog 
(Format | Paragraph). The top section of this tab addresses indentation.  

 
Figure 8. This tab of the Paragraph dialog lets you determine the indentation of a 
paragraph, as well as the white space before and after it. The indentation settings 
shown create a hanging indent in which the first line of the paragraph sticks out 
farther to the left than the rest of the paragraph. 

As you’d expect, the Before text and After text settings control indentation of the 
paragraph as a whole from the left and right margins, respectively. Use a positive number to 
move the paragraph in from the margin and a negative number to set the paragraph outside  
the margin. 

The First line setting controls the left-hand position of the first line of the paragraph 
relative to the indentation of the whole. When it’s set to 0, the first line begins at the same 
position as the rest of the paragraph. When First line is set to a positive number, that line is 
indented more than the paragraph itself. When First line is set to a negative, the paragraph has 
a hanging indent. 

Figure 9 shows a variety of margin settings. 
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Figure 9. The indentation settings in the Paragraph dialog let you create paragraphs 
with quite a few different formats. 

How do I leave white space between paragraphs? 
While you can use first line indentation to indicate the beginning of a new paragraph, in many 
documents, it’s preferable to have every paragraph begin at the left margin. In that case, you 
need space between paragraphs to indicate the break. While you can provide that space by 
pressing Enter twice at the end of the paragraph, that’s not a good choice. 

It’s better to give the paragraphs themselves (and even better to give your paragraph 
styles) the appropriate space preceding and following them. You do this on the Indents & 
Spacing tab of the Paragraph dialog (Figure 8). The Spacing section of that tab lets you 
indicate how much white space should precede the paragraph and how much should follow it. 
(In the printing business, this is known as leading, pronounced “led-ing.”) 

The paragraphs in Figure 9 are all set to have 6 points of leading before and none after. 
Although the dialog displays these settings in the measurement units you specify (see  
“What the heck is the ruler measuring?” earlier in this chapter), you can enter values in  
other units by including the units. So, even with inches displayed, I entered “6pt” in the Before 
paragraph spinner. 

How do I control the position of paragraphs? 
Individual lines of a paragraph at the top or bottom of a page with the remainder of the 
paragraph on the preceding or following page are called widows and orphans. In general, you 
can use the terms “widow” and “orphan” interchangeably. However, Writer specifically 
defines them. An orphan occurs at the bottom of a page; a widow occurs at the top. 

Widows and orphans make a document harder to read, so it’s often desirable to prevent 
them. Writer lets you control this through the Text Flow tab (Figure 10) of the Paragraph 
dialog (Format | Paragraph on the menu). 
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Figure 10. The Text Flow tab of the Paragraph dialog gives you control over orphans 
and widows, as well as letting you specify that a paragraph should be on the same 
page as the paragraph that follows it. 

You can specify not only the prevention of orphans and widows, but also exactly what 
constitutes an orphan or a widow. Use the appropriate check box to turn orphan or widow 
control on and off. When the check box is selected, the spinner to its right lets you determine 
the minimum number of lines that must appear on the page from a given paragraph. The 
default setting for both is two, meaning one line alone is an orphan or widow, but two lines 
together are sufficient. 

 
In Word, widow and orphan control are linked, so you get both or neither. 
Writer gives you independent control over the two conditions. In addition, in 
Word, you can’t determine what constitutes a widow or an orphan. 

In some cases, you want an entire paragraph on the same page, regardless of its length. 
Select the Do not split paragraph check box to keep the whole paragraph together. This  
setting is incompatible with widow and orphan control, so you have to turn those off before 
you can select the check box. (Of course, if the paragraph is longer than a page, it continues  
on the next page.) 
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There’s one more situation you may want to control. In some cases, you want to ensure a 
particular paragraph appears on the same page as the paragraph that follows it. For example, 
you rarely want to leave a heading at the bottom of the page with the material it heads on the 
next page. Select Keep with next paragraph for the heading paragraph to prevent this kind of 
orphan. 

How do I set tabs? 
As in Word, tabs in Writer are associated with a paragraph, but unlike Word, you actually set 
them in the Paragraph dialog. Use the Tabs tab (shown in Figure 11).  

 
Figure 11. You can set a variety of tabs in the Paragraph dialog. 

For each tab, you have three options: position, type, and leader (in Writer, called fill 
character). Position, of course, determines where to place the tab stop.  

Type determines what happens when you move to that tab stop. With a left tab, typing 
proceeds to the right of the tab. With a right tab, the end position for the text is fixed and typed 
characters move to the left. Use right tabs, for example, to position text at the right margin. 
With a centered tab, the middle of the text is fixed at the tab stop and characters move to both 
sides. Finally, a decimal tab is handy for dealing with columns of figures. The decimal point 
appears at the tab stop, with the integer portion to the left and the decimal portion to the right. 
For decimal tabs, you can specify the character that serves as the decimal point. 
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The fill character determines what, if anything, fills the space left empty by the tab.  
This is useful in such places as a table of contents, or an index, where you want to use dots 
between the item and the page number. You can choose any of several options provided or 
specify a character. 

Figure 12 shows a document using a variety of tab types and settings. Nonprinting 
characters have been turned on (View | Nonprinting Characters) to make it easier to see the 
structure of the document. 

 
Figure 12. Writer supports a variety of tab types, as well as the ability to add leaders 
to a tab stop. 

To add a tab using the dialog, specify the position, type, and fill character you want, and 
then click the New button. 

You can also specify tabs by setting them on the Ruler. Use View | Ruler to display the 
ruler, and then click at the position where you want the tab. By default, this creates a left tab. 
Right click your new tab to change its type or double-click anywhere on the Ruler to open the 
Tabs tab of the Paragraph dialog. 

How do I right-align text? 
You have several choices for putting text at the right margin. The appropriate choice depends 
on the situation.  

To right-align an entire paragraph, use the Align Right button on the Text Object toolbar 
or choose Right on the Alignment tab of the Paragraph dialog. 

If you want to right-align some text on a line where other items appear to the left, as for 
example in page headings, use a right tab. (See the preceding section “How do I set tabs?”)  

Finally, if you need to have multiple lines of both left-aligned and right-aligned text with 
word wrap in each group, use a table with two cells. Set the left cell for left alignment and set 
the right cell for right alignment. See Chapter 7, “Dressing up Documents,” for the details of 
creating and using tables. 

How do I specify the kind of paper I’m using? 
Not surprisingly, the size and orientation of paper is considered Page formatting and is part  
of the Page Style dialog. Paper settings are found on the Page tab of the dialog, shown in 
Figure 13. 
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Figure 13. This tab of the Page Style dialog lets you specify the size and orientation 
of your paper, as well as the margins you’re using. 

The Format drop-down list includes most of the widely used sizes for both paper and 
envelopes. When you make a choice from this list, the Width and Height spinners change to 
reflect your choice and the diagram of the page at the upper right adjusts. 

If the paper size you’re using isn’t in the list, you can set the Width and Height yourself. 
When you do so, the Format drop-down list shows “User.” 

Use the Orientation option buttons to indicate whether you’re printing across the narrow 
(portrait) or wide (landscape) edge of the paper. Again, the Width and Height spinners change 
to reflect your choice, as does the diagram. 

How do I set margins? 
The Page tab of the Page Style dialog (Format | Page, Figure 13) also controls margins. The 
Page layout drop-down list in the Layout settings section determines whether the margins you 
set apply to all pages or only some of them. There are four possibilities, shown in Table 1. 
The choice you make here can change the labels for the margin setting spinners, and modify 
the diagram of the page.  
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Table 1. Your choice for Page layout determines how Writer applies the margins  
you set. 

Page 
layout 

Meaning 

Right and left These settings apply to all pages. 
Mirrored These settings apply to all pages, but you specify Inner and Outer margins rather than Left 

and Right. You would probably use this setting for a book. 
Only right These settings apply only to right-hand pages. 
Only left These settings apply only to left-hand pages. 

 
Ordinarily, you specify left, right, top, and bottom margins for a page, but when you 

choose Mirrored for Page layout, the first two settings instead let you indicate the margin for 
the inside edge of the page (the right margin of a left-hand page, and the left margin of a right-
hand page) and the outside edge of the page. This allows you to leave larger margins on the 
binding edge. 

How do I create bulleted lists? 
It’s easy to set up a bulleted list. Click the Bullets On/Off button on the Text Object toolbar to 
begin bulleting. Once you start bulleting, each time you press Enter, the next line is bulleted as 
well. To stop bulleting, either click the button again to turn bulleting off or press Enter twice at 
the end of a line. 

If you already typed the text you want bulleted, highlight it and click the Bullets On/Off 
button. If only one paragraph is to be bulleted, just position the cursor anywhere in the 
paragraph and click the Bullets On/Off button. 

Bulleted items you create this way use a small round bullet (the first group in Figure 14). 
You can specify other bullets using the Number/Bullets dialog (Figure 15) available on the 
Format menu. Two different tabs offer bulleting options: the Bullets tab and the Graphics tab. 
In either case, click the bullet style you want, and then click OK. The second group in Figure 
14 uses one of the choices from the Bullets tab.  

 
Figure 14. A variety of bullet styles is available. By default, bulleted items use the 
small dot shown in the first group. 
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Figure 15. The Bullets tab of the Number/Bullets dialog lets you choose the bullet 
style you want. 

 
Figure 16. One bulleted list can contain another. Use Tab to move in and Shift-Tab to 
move out. 

In some situations, you want to put one bulleted list inside another, in a sort of outline 
format. You can do this in a couple of ways. 

To use the same bullet symbol at all levels of the list, start bulleting as usual. When you 
want to create a sub-list, press Tab to move in one level. Figure 16 shows an example of such 
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a list. Use Shift-Tab to move back to the main list. Use the Increase Indent and Decrease 
Indent buttons on the Text Object toolbar to move existing items to a different level of the list. 

You can also use a different symbol for each bulleted level. The easiest way to do so is by 
opening the Outline tab of the Numbering/Bullets dialog. The last option there offers four 
different bullet styles. 

Finally, you can build your own list of bullet symbols, using the Options tab (Figure 17) 
of the Numbering/Bullets dialog. Choose a level from the list on the left, and then use the 
Numbering drop-down list to indicate whether that level uses bullets, numerals, letters, roman 
numerals, or another choice. For bullets, click the Character button and choose the bullet 
symbol you want at that level.  

 
Unfortunately, there doesn’t appear to be a way to save a custom list of 
bullets once you create it. It applies only to the paragraph in which you’re 
using it. 

 
Figure 17. The Options tab lets you build your own list of bullet symbols or  
numbering formats. 
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 The gray background for the bullet (and for numbers in a numbered list) is a 
visual clue that the items were created automatically, not by typing. You 
can’t position your cursor in the gray area. The gray doesn’t appear when 
the document is printed. 

How do I create numbered lists? 
As with bullets, you have several choices for creating numbered lists. The simplest is to click 
the Numbering On/Off button on the Text Object toolbar before starting the list. In this case, 
the list uses arabic numerals with a period after each. Figure 18 shows an example. As with 
bulleted lists, click the button again to stop numbering, or press Enter twice. 

 
Figure 18. You can create a simple numbered list by clicking the Numbering On/Off 
button on the Text Object toolbar. 

To number existing paragraphs, highlight them and click the Numbering On/Off button. 
For more control over the numbering, use the Numbering type tab (Figure 19) of the 

Numbering/Bullets dialog. This tab lets you choose between arabic numerals, Roman numerals 
(both upper and lower case), and letters (both upper and lower case); it also provides some 
choices regarding the punctuation following the “number.” 
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Figure 19. The Numbering type tab lets you determine the numbering style for lists. 

As with bullets, you can put a numbered list inside another numbered list. When you use 
the default numbering or choose from the Numbering Type tab, the sub-list uses the same 
numbering style and begins again with “1” or “A.” Figure 20 shows an example. 

 
Figure 20. If you choose from the Numbering type tab, a sub-list uses the same 
numbering style and starts over from the beginning. 

Usually, when one numbered list is inside another, though, you really want an outline 
structure. Use the Outline tab (Figure 21) of the dialog to choose the outline format. 
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Unfortunately, none of the formats provided is exactly the normal style used for outlines, and 
only one offers more than four levels of different formatting. 

 
Figure 21. The Outline tab lets you chose the type of outline formatting you use. 

As with bullets, you can design your own numbered outline structure; use the Options tab 
of the dialog. The inability to save your custom outline formats is a serious limitation. 

How do I find out how long my document is? 
When you’re working in the default view, the status bar indicates the number of pages in your 
document. However, there are other useful statistics about a document, such as the number of 
words or characters. 

Statistical information about a document is available in the Properties dialog (File | 
Properties from the menu). The General tab of the dialog includes creation and modification 
dates for the file and the file size. The Statistics tab (Figure 22) gives you a whole collection 
of metrics. 
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Figure 22. The Statistics tab of the Properties dialog tells you how many “things” your 
document contains. 

At present, there’s no way to get the same information for a block of text through the user 
interface; you can do so with a macro. (See Chapter 18, “Macros and Automation.”) As 
journalists and others have reported to the OOo development community that counting words 
in a block of text is important to their daily process, it’s likely that feature will be added in an 
upcoming version. 

How do I print my document? 
Not surprisingly, the easiest way to print a document is to click the Print button on the 
Function toolbar. That sends the entire document to the default printer or, if it was previously 
printed on a different printer, to that printer. (The document keeps track of what printer it was 
printed on.) 

If you need different behavior, use File | Print or Ctrl-P to open the Print dialog (Figure 
23). The dialog lets you choose a printer, specify the pages to print, and indicate how many 
copies to print. 

You can get even more control over what prints by clicking the Options button to open the 
Printer Options dialog (Figure 24). This dialog lets you specify whether all components of the 
document print or only some of them. For example, you can eliminate graphics or tables.  
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The dialog also lets you control the pages that get printed based on content. You can print 
only the left pages or only the right pages, useful if you’re printing something like a book, but 
your printer can’t print on both sides of a piece of paper without manual intervention. 

 

 
Figure 23. Use the Print dialog to choose a printer, specify the pages, and how many 
copies to print. 

 
Figure 24. The Printer Options dialog lets you specify the portions of a document  
to print. 
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How do I create a PDF from my document? 
The Adobe Acrobat PDF format has rapidly become a nearly universal method for exchanging 
formatted documents. The free, downloadable reader means anyone can view a PDF 
document. 

Beginning with OOo 1.1, creating PDF files from Writer is as easy as can be. Choose File 
| Export as PDF from the menu or click the Export Directly as PDF button on the Function 
toolbar. In either case, the Export as PDF dialog appears to let you specify the file name for 
the resulting PDF file. 

When you use the Export as PDF option on the menu, the PDF Options dialog (Figure 
25) appears next. You have a couple of choices. First you can choose how much of the 
document to export: the entire document or just a portion of it. (You can specify an individual 
page or a range of pages, such as “2-5.”) Second, you can determine the quality of the output 
by choosing a compression style. When the resulting file will only be viewed on monitors, 
lower quality is usually acceptable. 

 
Figure 25. The PDF Options dialog determines whether you export the entire 
document or just a section, and the quality of the output. 

When you use the Export Directly as PDF button on the Function toolbar button, the 
entire document is exported, using the most recent compression choice. 

Summary 
The information in this chapter should get you started creating documents with Writer. In the 
next chapter, I look at more advanced features, such as including pictures and tables. 

 

 

 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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Chapter 7 
Dressing Up Documents 

Once you get basic documents down, you will probably want to use some more complex 
features of Writer. This chapter shows you how to add page numbers, tables, and 
graphics to your text documents, plus how to perform a mail merge and more. 

How do I put things like date and time into a document? 
There are some pieces of data frequently used in documents. Perhaps the most common is the 
current date, but you might also want to include the author’s name, the document’s original 
creation date, and other information. 

You add this sort of information by choosing Insert | Field from the menu, and then 
choosing the appropriate item to insert. A submenu includes the most common items to save 
time and clicks. If the item you want isn’t on that list, choose Other to open the Fields window 
(Figure 1). The window is divided into tabs organized by the type of information presented. 

 
Figure 1. The Fields window lets you insert data items like the current date and time, 
the author of the document, when it was last printed, and so forth. 
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You can also insert field data by clicking the Insert Fields button on the Main toolbar. (By 
default, it’s the second from the top). If you click it and release, the Fields dialog opens. If you 
click and hold (long click), a list of commonly used fields appears (the same list as the 
submenu for Insert | Fields). 

The Fields window is a little different from most Writer dialogs. When you choose Insert 
(the default action), the dialog doesn’t close. However, it does insert the currently highlighted 
item into the document at the current insertion point. Because this window isn’t a dialog, you 
can click in the document, make changes, and return to the Fields window to insert another 
field. When you finish inserting fields, choose Close to close the window. 

Choosing the field you want to insert is a multi-step process. Once you’re on the right 
page (the Document and DocInformation tabs contain this kind of information), you choose 
the type of field from the list on the left. (In Figure 1, Time is chosen). The center list offers 
data items of that type, if there’s more than one. Finally, many of the items offer multiple 
formats. For example, in Figure 1, you have a choice of how the time appears in the document. 

The Date and Time types on the Document tab give you a choice between inserting the 
current date and time, or inserting an updateable date or time. Choose Date (fixed) or Time 
(fixed) to insert the current date or time. Choose Date or Time to insert a field that updates 
each time you open the document. 

Once you insert some fields into a document, you normally see the current value of the 
fields. You can see their definition instead by pressing Ctrl-F9 or choosing View | Fields from 
the menu. Ctrl-F9 or View | Fields again toggles them back to showing their values. 

How do I insert the path and filename of the document? 
The list of fields includes the filename in several formats. Use the Document tab of the Fields 
dialog (Insert | Fields | Other from the menu) and click File name in the Type list. In the 
Format list, choose the format you want—for the path and filename choose Path/File name. 

How do I add page numbers? 
The list of fields available for a document includes both the current page number and the 
number of pages in the document. So, you add page numbers in the same way you add date, 
time, or other items. (See the preceding section.) 

If you choose Page Numbers or Page Count from the Insert | Fields submenu, they use 
arabic numerals. If you prefer another format, open the Fields window (Insert | Fields | Other 
from the menu), choose the appropriate Type, and then the desired Format. Arabic numerals, 
Roman numerals, and letters are available.  

To have “Page x of y” formatting, click where you want the page numbers to appear 
(typically in a header or footer—see “How do I get page headers and footers?” later in the 
chapter), type “Page ”, insert the Page Numbers item (Insert | Fields | Page Numbers), type  
“of ”, and finally insert the Page Count item (Insert | Fields | Page Count).  

How do I change the page numbers? 
Sometimes, you want to do something more complex than just number the pages in a 
document starting with 1. Most often, you either want to use no numbers on some initial pages 
(such as a title page), and then start numbering the main body of the document from 1, or you 
want to have several different groups of numbers in a document, each starting from 1. For 
example, it’s common in books for the front matter (the table of contents, the foreword, and so 
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forth) to be numbered with small roman numerals and for the main part of the book to use 
arabic numerals starting from 1. 

The solution for this problem only works when you explicitly start a new page. (That’s 
usually the case when you want to change page numbers.) At the end of the text before the 
page with the new numbering, choose Insert | Manual Break from the menu. This opens the 
Insert Break dialog (Figure 2). Choose the Page Break option button, and then choose the 
page style for the new page. Once you make a style choice, the Change page number check 
box is enabled. Select it and specify the page number for the new page in the spinner. 

  
Figure 2. To change the page number for subsequent pages, insert a manual  
page break. 

A different approach works when you want to change the number on the first page of a 
document. (You can use this approach at any time, actually.) Put the cursor in the first 
paragraph of the page where the numbering should change (or the first page, if you want to 
start with a number other than 1). Choose Format | Paragraph from the menu to open the 
Paragraph dialog. Choose the Text Flow tab (shown in Figure 10 of Chapter 6, “Creating 
Simple Documents”). In the Breaks section of the page, select the Enable check box. Once you 
do so, a number of controls are enabled. Make sure the Type drop-down list is set to Page and 
the Position drop-down list is set to Before. Select With Page Style and make sure the drop-
down list shows the Page Style currently in use. In the Page Number spinner, specify the 
number for the page. 

How do I get page headers and footers? 
Headers and footers are the portions of a page at the top and bottom and contain information 
that should appear on each page, such as titles, page numbers, and so forth. To add a page 
header to a document, choose Insert | Header from the menu and make sure Default is selected. 
To add a footer, choose Insert | Footer and select Default. These choices add a header or footer 
using the default settings for the page’s style. 

You can fine tune the settings using the Header (Figure 3) and Footer tabs of the Page 
Style dialog (Format | Page). The dialog lets you specify the position of the header or footer, 
as well as whether the same header and footer are on even and odd (left and right) pages. In 
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this book, for example, the odd page headers include the chapter name and title, while the even 
headers hold the book’s title. 

 
Figure 3. You adjust the settings for a header using this tab of the Page Style dialog. 
Use the Footer tab to modify footer settings. The two are independent of each other. 

Writer handles the issue of different headers for a first page differently than Microsoft 
Word. In Word, you select a check box to indicate that the first page has headers different 
from the rest of the pages in the chapter. In Writer, you use a separate page style. You can 
modify the built-in First Page style for this use, or create your own style to use for first pages. 
(See Chapter 5, “Making Life Easier with Templates and Styles” for details on creating and 
modifying styles.) In either case, make sure the Next Style setting for your first page style 
points to the appropriate page style. If you use the same headers on odd and even pages, point 
to the regular page style (Default or some other). If you use different headers for odd and even 
pages, you probably want to point to the style for even pages, because in that situation, usually 
a chapter or section begins on the right (odd) page. 

Once you turn headers and/or footers on, putting content in them is easy. Make sure 
you’re not in Online Layout view (View | Online Layout), and then simply click in the header 
or footer you want to edit. When you’re done, click in the main body of the document. 
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How do I change headers or footers in the middle of  
a document? 
Like so much else in OOo, headers and footers are linked to styles. So, to change the header or 
footer within a document, you need to use a different page style. That is, once you add a 
header or footer to a document, that information is part of the page style for the document. 
When you want to change the header or footer layout, create a new page style and use that 
style for the pages that need the modified header or footer. See Chapter 5, “Making Life Easier 
with Styles and Templates” for the details of creating styles. 

How do I add pictures to a document? 
According to the old saying, a picture is worth a thousand words, and adding pictures to a 
document can make the difference between clarity and confusion.  

You can add pictures to Writer documents in several ways: cut-and-paste, drag-and-drop, 
through the menu (Insert | Graphics | From File), using the Insert button on the Main toolbar, 
or from the Gallery. (See “What is the Gallery?” in Chapter 4, “The OpenOffice.org Interface” 
for an explanation of the Gallery.) When you choose Insert | Graphics | From File from the 
menu or Insert Graphics from the main toolbar, the Insert Graphics dialog opens. This is a 
specialized version of the standard File Open dialog that includes a preview panel. When  
you click a graphic file in the dialog, you can see what it looks like. There’s a slight delay 
before the preview appears, so if you know which file you want, you don’t have to wait for  
it to display. 

For a list of the graphic formats Writer supports, check the Files of type drop-down list in 
the Insert Graphics dialog. 

Whichever way you add the picture, by default, it’s anchored to the current paragraph, 
which means it moves with that paragraph. Table 1 lists the choices for anchoring a picture. 
You can change the anchoring of a picture by right-clicking it and choosing Anchor, using the 
Type page of the Graphics dialog (shown in Figure 4, use Format | Graphics from the menu or 
Graphics on the picture’s shortcut menu to open it), or on the Graphics toolbar that appears 
when a graphic object is selected. (You may need to click the left arrow at the end of the 
toolbar to switch to the right set of buttons.) 

Table 1. You can anchor graphics in a variety of ways. Your anchoring choice 
determines how the graphic moves as text changes 

Anchoring type Effect 
To Page Attaches the graphic to the page that contains it and it cannot move to another 

page. You can indicate where on the page the graphic is positioned. 

To Paragraph Attaches the graphic to the paragraph current when it’s added. As that 
paragraph moves, the graphic moves with it. 

To Character Attaches the graphic to the character current when it’s added. As that 
character position moves, the graphic moves with it. 

As Character Does not attach the graphic to any other object Instead, it is positioned as if it 
is a character typed at the insertion point. 
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The type of anchoring determines your choices for positioning the graphic and for the 
interaction of text with it. Graphics anchored as characters can’t have text wrapped around 
them and have more limited choices for positioning. The other three anchoring choices let you 
determine whether the graphic is at the top, middle, or bottom of the anchoring object, and 
whether it anchors at the left, center, or right. Choose Alignment from the graphic’s shortcut 
menu or use the Type tab of the Graphics dialog to make these choices. 

 
Figure 4. The Graphics dialog lets you determine how a picture is anchored, 
positioned, and much more. 

You can wrap text around graphics, except for those anchored as characters. There are 
several choices for how text wraps, including running the text right through the graphic (as 
you might with a watermark or a “Draft” designation). To specify wrapping, choose Wrap 
from the graphic’s shortcut menu or use the Wrap tab of the Graphics dialog. 

Be aware that the Graphics dialog offers more options for both positioning and wrapping 
than the shortcut menu. 

By default, all pictures use a style named Graphics, which is a Frame style. (See Chapter 
5, “Making Life Easier with Templates and Styles” for a full discussion of styles and style 
types.) You can modify this style or create additional styles with the settings you want, so you 
don’t have to adjust each picture as you insert it. 
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How do I put a table in a document? 
As with pictures, there are several ways to add a table (something like Table 1 earlier in this 
chapter or Figure 10 later in the chapter) to a document. You can use Insert | Table from the 
menu, Ctrl-F12, or the Insert Table button on the Main toolbar (by default, it’s the first 
button). Whichever technique you use, the Insert Table dialog (Figure 5) appears. In the 
dialog, you can specify the size of the table, as well as how it should behave if it reaches the 
end of a page. In addition, you can name the table. Tables are listed in the Navigator, so 
assigning a name makes it easy to identify. 

 
Figure 5. Use this dialog to define a table. Assigning a table a name makes it easier 
to identify it in the Navigator. 

As Figure 5 shows, the default size for a table includes two rows. If the Header check box 
is selected and there are at least two rows, the first row uses the Table Heading Style. All rows 
after the first use the Table Contents style, as does the first row when Header is cleared or only 
one row is specified. 

 
When the cursor is positioned inside a table, the Edit | Select All (Ctrl-A) 
functionality changes. The first time you Select All, all text in the current cell 
is highlighted (if there is any). Choose Select All again and the whole table 
is selected. A third Select All highlights all text in the document. 

Don’t worry about getting things exactly right when you insert the table. Once a table 
exists, you can change its settings in a variety of ways. To work on the table as a whole, with 
the cursor positioned in the table, choose Format | Table or choose Format from the table’s 
shortcut menu to open the Table Format dialog (Figure 6). In addition, the Cell, Row, and 
Column items on the Format menu and on the table’s shortcut menu offer control over various 
aspects of a table’s appearance and behavior. 
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Figure 6. The Table Format dialog lets you determine the width of a table’s column, 
add space above or below the table, as well as determine what happens when a table 
passes a page break. 

 
The behavior of the Ctrl-F12 shortcut varies, depending on the situation. 
When focus is inside a table, Ctrl-F12 opens the Table Format dialog. When 
focus is not in a table, Ctrl-F12 opens the Insert Table dialog. 

How do I set column widths? 
If you know how wide you want each column to be as a measurement, use the Columns tab of 
the Table Format dialog (Format | Table on the menu or Table on the table’s shortcut menu) to 
specify them. Be aware that changing the value for one column affects the column to its right, 
which gets wider or narrower to keep the total table width the same. (Changing the last column 
impacts the first.) You can change this behavior by selecting the Adapt table width check box 
on the same page; when that item is selected, the size of the table changes based on the column 
widths you specify. (When Alignment is set to Automatic for the table, which is the default, 
the width of the table is fixed and this check box is disabled. Choose a different alignment on 
the Table tab of the dialog to allow you to change the table size.) 

If you prefer to “eyeball” the column widths, you can use the keyboard. Position the 
cursor in the column you want to change and use Alt-Left Arrow to shrink the cell or Alt-
Right Arrow to enlarge it. The effect of this action on other columns depends on a setting in 
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the Options dialog (Tools | Options on the menu). Figure 7 shows the Table page of the Text 
Document section of the Options dialog, where you specify a number of default behaviors. 
Sizing of rows and columns via the keyboard is affected by the setting for Behavior of 
rows/columns. When this item is set to Fixed, a change to one column affects the next column. 
When it’s set to Fixed, proportional, a change to one column affects all other columns 
proportionally. Finally, when it’s set to Variable, the table size changes to accommodate 
changes to a column’s widths and other columns keep their sizes. 

 
Figure 7. This page of the Options dialog lets you determine default behaviors for 
tables, including what happens when resizing columns and rows. 

 
The Options dialog setting for Behavior of rows/columns affects only 
resizing with the keyboard, and not other kinds of resizing. This appears to 
be a bug and may be fixed in later versions of OOo. 

You can also resize columns with the mouse. Position the mouse over the divider between 
columns, click, and drag. (When you get the mouse in the right place, it turns into a resizer 
icon.)  

If you want to change a single column, you can use the Column Width dialog (Figure 8), 
that opens by choosing Format | Column | Width from the menu or Column | Width from the 
shortcut menu. As with the Table Format dialog, changing the width of one cell changes the 
width of the adjacent cell. 
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Figure 8. Use the Column Width dialog to set the width of individual columns. 

Finally, the best choice for resizing cells is often to wait until you fill the table with 
information, highlight the whole table, and choose Format | Column | Optimal Width from the 
menu or Column | Optimal Width from the shortcut menu. Writer then figures out the best 
width for each column based on its contents. If one or more columns or cells within columns 
are highlighted, only those columns are affected. 

When you highlight one or more columns, there’s also a Space Equally option on the 
Column submenu. 

 
Be careful not to confuse the Format | Column menu item, which affects 
columns of a table with the Format | Columns item, which affects columns on 
a page. See “How do I put multiple columns in a document?” later in the 
chapter for information on using columns on pages. 

How do I change the height of a row? 
As with column widths, there are several ways to change a row’s height. You can use Alt-Up 
Arrow to shrink a row and Alt-Down Arrow to increase it. Here, too, the setting for Behavior 
of rows/columns in the Options dialog comes into play. When resizing a row with the 
keyboard, you can never make it too small to hold its contents. 

You can also adjust the height of a row by choosing Format | Row | Height from the menu 
or Row | Height from the shortcut menu. The Row Height dialog (Figure 9) appears. When Fit 
to size is selected, the height you specify is a minimum—the row is the larger of the specified 
height and the height necessary to contain its contents.  

 
Figure 9. You can set a row’s height to a specific value or tell it to choose a height 
based on its contents. 

When Fit to size is cleared for a row, the submenu for row height (Format | Row | Height 
on the menu, Row | Height on the shortcut menu) also includes an Optimal Height item. 
Choosing that item is the same as selecting Fit to size in the dialog. 
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How do I control the behavior of a table at a page break? 
You have several options regarding tables and page breaks. You can require the table to 
appear on a single page (assuming it fits on one page) or not. If you allow a table to be split 
across pages, you can specify whether the table header repeats on pages after the first. 

If you know you want to prevent a table from being placed across multiple pages when 
you create it, check Don’t split table in the Insert Table dialog. If you already created a table 
and want to change this setting, use the Do not split table check box on the Text Flow tab of 
the Table Format dialog (Format | Table). 

When a table splits across multiple pages, you may or may not have headings that should 
appear on each page. Again, you can make this choice either when you create the table or 
later. In the Insert Table dialog, select the Repeat Header check box; in the Table Format 
dialog, select the Repeat heading check box on the Text Flow tab. 

How do I make an irregular table? 
By default, every row of a table has the same number of columns and every column has the 
same number of rows. However, there are situations where you might want some other 
arrangement. One typical case is putting one heading across several columns. Figure 10 shows 
an example of such a table. 

 
Figure 10. You can merge and split cells in a table to create irregular arrangements. 

To consolidate several cells into a single cell, highlight the cells you want to combine, and 
then choose Format | Cell | Merge from the menu or Cell | Merge from the shortcut menu. The 
highlighted cells combine into a single result cell. 

You can also divide a cell into multiple cells. Make sure focus is in the cell or cells you 
want to split and choose Format | Cell | Split from the menu or Cell | Split from the shortcut 
menu. The Split Cells dialog (Figure 11) displays. Specify the number of cells you want to 
create from the single cell, and then choose the direction. Choosing horizontal puts the new 
cells in a single column, but in different rows. Choosing vertical does the reverse, resulting in 
several cells in the same row, but in different columns. 
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Figure 11. You can split a cell into multiple rows or multiple columns, but not both. 

Be aware that the behavior of irregularly shaped tables can be confusing. Cells that are 
merged or split don’t necessarily resize with the rest of their row or column, so you can have 
multiple cells in what seems to be the same row that are all different heights. 

How do I have more than one heading row? 
For most tables, it’s sufficient to repeat a single row on each new page on which the table 
appears. However, in some cases, you want to have several rows of headings before the actual 
data (as in Figure 10). Writer’s solution to this problem is a little strange. 

Highlight the existing header row. Use Format | Cell | Split to turn it into multiple rows. 
All the newly created rows are treated as header rows, along with the original. 

Unfortunately, this means header rows are particularly prone to the problem discussed in 
the last paragraph of “How do I make an irregular table?” To get the appearance you want, 
you may have to assign explicit row heights to all the cells involved. 

How do I control the lines around and within a table? 
The Borders tab (shown in Figure 12) of the Table Format dialog (Format | Table on the 
menu) controls the lines around and within a table. The Line Arrangement option buttons offer 
five common set-ups, including no lines at all, and lines both around the entire table and 
between all cells. To create a more complex arrangement, choose the line style you want from 
the Style list, and then click in the diagram where you want that line to appear. Be aware that 
even with all borders turned off, you will see faint lines around the tables cells while editing. 
However, those lines do not print. 
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Figure 12. The Borders tab of the Table Format dialog controls the lines around and 
within a table. You can choose a standard arrangement by clicking one of the line 
arrangement option buttons, or you can set the individual border and grid lines by 
choosing the type of line you want and clicking in the diagram. 

How do I put multiple columns in a document? 
Columns in a document can work in two ways. One type is often called “newspaper-style 
columns” or “snaking columns,” where text goes to the bottom of one column and then 
continues at the top of the next (as in Figure 15 later in this chapter). As the name implies, this 
kind of column is used in newspapers, magazines, and newsletters. The other kind of column, 
sometimes called “parallel columns,” allows information in different columns to be adjacent to 
each other, as in a telephone book. 

The best way to create parallel columns is using a table. Depending on the data, a one-row 
table may be sufficient or you may need multiple rows. The secret to giving the appearance of 
columns is to turn all borders off for the table, as described in “How do I control the lines 
around and within a table?” earlier in this chapter. 

There are two ways to create snaking columns in Writer. If you want an entire page to 
have the same number of columns, use the Columns tab (Figure 13) of the Page Format dialog 
(Format | Page on the menu). You can choose one of several common arrangements or set up 
as many columns as you want, with each having its own width. You can also control the 
presence or absence of lines between columns. 
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Figure 13. To set up an entire page with columns, use the Columns tab of the Page 
Style dialog. 

If you need only part of a page to have columns, use sections. Writer’s sections are quite 
different from Word’s. In Word, inserting a section break creates a new portion of the 
document with its own settings for paper size and type, page layout, headers and footers, and 
so forth. Writer’s sections are simply insertions in the document that can have a different 
number of columns and a different background color. 

To switch from one arrangement of columns to another on a page, use Insert | Section 
from the menu, which opens the Insert Section dialog (Figure 14). You can name the new 
section, making it easier to identify in the Navigator. The Columns page of the dialog is 
identical to the Columns tab of the Page Format dialog and allows you to specify the number 
of columns in this section. 
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Figure 14. The Insert Section dialog lets you insert multi-column sections into a 
document. Use it when you want only part of a page to have multiple columns. 

When you choose Insert from the Insert Section dialog, the new section is added to the 
document at the cursor location. Visually, it looks like a table with one row and the specified 
number of columns. However, unlike a table, text snakes from one column to the next. Figure 
15 shows an example with three columns; spacing between columns is set to 0.2”. 

 
Figure 15. Sections let you use multiple columns for only part of a page. The borders 
around each column do not print. 

To change the structure of a section, choose Format | Sections from the menu to open the 
Edit Sections dialog (Figure 16). Choose the section you want to change. To change the 
number of columns or the background color, click the Options button.  
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Figure 16. You can modify a section after you add it by choosing Format | Section 
from the menu. Click the Options button to see the column arrangement and other 
details for the current section. 

How do I get my headings to show up in the Navigator? 
One of the most useful features of the Navigator is its ability to show you the overall structure 
of a document. When you expand the headings section, you see the outline of your document. 

However, to do so, you have to tell Writer what are the headings in your document. By 
default, you indicate headings by using the built-in styles Heading 1, Heading 2, and so forth. 
Any paragraphs using those styles appear in the Navigator. 

In some documents, however, you may want to use custom styles for headings. You can 
tell Writer which styles constitute headings using the Outline Numbering dialog (Figure 17), 
available by choosing Tools | Outline Numbering from the menu. 
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Figure 17. To specify your own styles as headings, choose the level from the Level 
list, and then choose the appropriate style from the Paragraph Style drop-down list. 

For each heading style you use, pick the outline level it applies to in the Level list, and 
choose the style in the Paragraph Style drop-down list.  

 
Unfortunately, your settings for headings are saved only if you actually use 
the heading styles you specify in the document or template. Since you rarely 
want to actually put one of each type of heading in a template, that makes 
setting this up once and forgetting it difficult. 

How do I do a mail merge? 
Mail merge is the killer use of word processors, the task that put them on desks in millions of 
offices around the world. Not surprisingly, Writer can combine a form letter with data to 
produce personalized results. 

Writer’s approach to mail merge is quite different from Microsoft Word’s and there’s no 
tool like the Mail Merge Helper to walk you through the process. Nonetheless, it does involve 
the same three steps: setting up a data source, creating a document that includes data from a 
data source, and performing the actual merge. 
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Setting up a data source 
A data source in OOo can come from any of a number of places. The first time you run OOo, 
it prompts you to set up an Addresses data source, and allows you to point to the address book 
that provides the data. You can set up additional data sources using the Data Source 
Administration dialog. OOo can use a number of types of data, including a spreadsheet, a 
delimited text file, an ODBC data source, dBase format tables, and a number of others. The 
details of defining and manipulating data sources are covered in Chapter 17, “Managing Data 
with OpenOffice.org.” 

For mail merge, the best way to access data is through the Data Sources window (Figure 
18); choose View | Data Sources from the menu, click the Data Sources button on the Main 
toolbar or press F4 to open it. 

 
Figure 18. The Data Sources window allows you to drag data into documents and to 
specify the fields to use in a mail merge. 

Once you define a data source, you can use it for many different mail merge documents. 

 
Writer can’t use another Writer document as the data source for  
a merge. 

Creating the mail merge document 
The second step in performing a mail merge is to create the document to be merged. (In 
Microsoft Word, this is the “main document.”) A mail merge document contains all the text 
that’s to be the same in each case, as well as placeholders for the data to be inserted. 

To create a mail merge document, start with a new text document (or open an existing 
document you want to turn into a mail merge document). Open the Data Sources view window 
(View | Data Sources or the Data Sources button on the Main toolbar). At each point where 
you want to insert data, click the name of the field to be inserted in the Data Sources view 
window, drag the field name to the insertion point, and then drop it. The name of the field 
surrounded by angle brackets is inserted into the document. Figure 19 shows an example. 
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Figure 19. When you drag a field name from the Data Sources view window into a 
document, it appears with angle brackets to indicate that it will be replaced with  
actual data. 

Be careful to drag the field name, not the field data. You can drag actual data from the 
Data Source view window into a document, but that puts the data values themselves into the 
document rather than creating a mail merge document. You know you did it right when the 
entire column is highlighted in the Data Sources view window and the field name appears in 
angle brackets with a gray background. 

Once you create the mail merge document, it’s a good idea to save it before performing 
the actual merge. 

Doing the merge 
To perform the merge, choose Tools | Mail Merge from the menu. A dialog asks whether you 
want to create (that is, merge) from the current document or a template. If the main document 
is already open, choose “From this document.” Next, the Form Letter dialog (Figure 20) 
opens. In this dialog, you choose which records to merge and what to do with the results. The 
easiest way to include a record in the merge is to click the gray button next to it in the Form 
Letter dialog. To select more than one record, use Shift-Click or Ctrl-Click. (Shift-Click 
selects everything from the record you last clicked to the one you’re now clicking on; Ctrl-
Click lets you select individual records while leaving previously selected rows chosen. In 
Figure 20, Shift-Click was just used at the cursor position to leave three records selected.) 

 
Figure 20. The Form Letter dialog sets things up for the actual mail merge. Choose 
the records to merge and the output destination. 



112  OOo Switch: 501 Things You Wanted to Know 

Another way to choose the records to include in the merge is to select them in the Data 
Sources window, and then click the Mail Merge button in that window. A smaller version of 
the Form Letter dialog appears, omitting the data sources section at the top. 

The Output section of the Form Letter dialog determines where to send the results. By 
default, the form letters created by the merge go to the printer. You can instead send them to 
files; a file is created for each record merged.  

When you choose the File option button, the Path and Generate file name from sections of 
the dialog are enabled, allowing you to specify the folder in which to store the results, and the 
mechanism for naming the resulting files. The documents can be named based on the data in 
one of the fields, or you can specify a stem that is combined with a sequential number to create 
the file name. 

 
There’s no way to send mail merge results to a new document, perhaps the 
most common choice in Word.  

Limiting records in a mail merge 
As noted in the preceding section, you can manually choose which records to merge. 
However, often you may want to filter the records to be merged based on their content. You 
can handle simple conditions using the Form Letter dialog or the Data Sources window. To 
create a filter, click the Default Filter button in the dialog (it looks like a funnel). The Filter 
dialog (Figure 21) opens and you can specify up to three conditions to apply to the data. For 
each condition, you specify a field, the operator to apply (such as “=” or “<”), and the value to 
match. In Figure 21, data is limited to those records where the Year field is equal to 2000. 

 
Figure 21. The Filter dialog lets you apply simple conditions to the data source  
before merging. 

When you click OK in the Filter dialog, the condition(s) you specify are applied to the 
data source and only the matching records display. More importantly, if you perform the 
merge at this point, it only merges the records displayed. 

To remove this sort of filter, but leave it defined (that is, to see all records), click the 
Apply Filter button in the Form Letter dialog or Data Sources window. This button is a  
toggle that lets you turn the filter on and off. To clear the Filter dialog, click the Remove 
Filter/Sort button. 

You can handle more complex filtering requirements by defining queries based on the 
data. You create a query from the Form Letter dialog, the Data Sources window, or the Data 
Source Administration dialog. See “Can I define subsets of my data?” in Chapter 17, 
“Managing Data with OpenOffice.org” for instructions on creating queries.   
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You can use a query rather than the original table in the Form Letter dialog or Data 
Sources window. Expand the Queries section for your data source, choose the query that 
includes the appropriate records and fields for your merge, and then perform your merge  
as usual. 

Sorting merge results 
In addition to filtering data to include only some records, you can also determine the order of 
the results. When merging to files, the order doesn’t really matter, but when merging to the 
printer, you may want your results in a particular order. For example, in some cases, you want 
letters in zip code order to facilitate bulk rate mailing. 

You specify the sort order by modifying the order of the records in the Form Letters 
dialog or Data Sources window. To sort based on a particular field, click the field name to 
select it, and then click the Sort Ascending or Sort Descending button. 

You can also specify more complex sorting criteria by clicking on the Sort Order... button. 
That opens the Sort Order dialog (Figure 22). Choose the field to sort on and the sort order 
(ascending or descending) for each of three fields. The fields you choose apply in order, so in 
Figure 22, records sort first on Author. If any records have the same author, they then sort on 
Booktitle. 

 
Figure 22. The Sort Order dialog lets you specify sorting on up to three columns. 

How do I create envelopes? 
Creating envelopes with Writer isn’t difficult, but it can be tricky to get them just right. The 
process also isn’t quite as automated as in Microsoft Word. 

Choose Insert | Envelope from the menu, which opens the Envelope dialog (Figure 23). 
The first tab of the dialog defines the envelope contents. By default, Writer inserts the User 
Data from the Options dialog (Tools | Options, the User Data page in the OpenOffice.org 
section) as the sender information. Unlike Word, however, addressee information isn’t 
inserted automatically. You can cut and paste it from the document. However, be sure to copy 
the address from the document onto the clipboard before you open the Envelope dialog. (You 
can also build a mail merge envelope using fields from any registered data source.) 
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Figure 23. The Envelope dialog lets you specify the sender and addressee, as well 
as the type of envelope and the way the printer handles it. 

Much of the work you need to do with envelopes has to do with printer interaction. The 
Format tab of the dialog lets you specify the type of envelope and where to print on it. The 
Printer tab specifies the interaction of the envelope with the printer. 

The Format drop-down list of the Format tab (Figure 24) lists a number of standard paper 
sizes (including envelopes such as #10 business size). When you choose one of those, the 
other controls reflect the settings for that type, but you can adjust them if you like. The 
diagram on this tab shows you the layout of the envelope. 
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Figure 24. Use the Format tab of the Envelope dialog to specify the size and layout of 
your envelope. A number of standard envelope types are predefined. 

The Printer tab (Figure 25) of the dialog lets you specify how envelopes feed into the 
printer. It also gives you access to the Printer Setup dialog where you specify, for example, 
manual feed for the envelope rather than a paper tray. Click the Properties button to make 
changes to the printer setup. 

 
At present, specifying an envelope type in the Envelope dialog doesn’t 
change the paper type for the printer. This results in envelopes printing poorly 
(with addresses not in the right places). To solve the problem, use the 
Properties button on the Printer Setup dialog. When the Document Properties 
dialog opens, choose the Layout page. Click the Advanced button to open the 
Advanced Options page (Figure 26). On that page, change the Paper Size 
setting to match your envelope type. 
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Figure 25. Use the Printer tab of the Envelope dialog to indicate how envelopes feed 
into your printer. 

 
Figure 26. Be sure to change the Paper Size in the printer’s Advanced Options dialog 
to ensure your envelope prints correctly. 
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Once you set up the envelope and printer correctly, you have two choices in the Envelope 
dialog. Choose New Doc. to create the envelope as a new, separate, document. Choose Insert 
to add the envelope to the same document. 

Summary 
While there are still more features in Writer, the information in this chapter and the preceding 
chapter should let you create just about all of the documents you need on a daily basis. If you 
need more advanced Writer features, the experience you gained, along with the Help file, 
should enable you to tackle those as well. 

 

 
 
 
 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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Chapter 8 
Creating Simple Spreadsheets 

Spreadsheet software was the breakthrough application for personal computers, the one 
that led to their widespread acceptance in the business world. OpenOffice.org’s 
spreadsheet application, Calc, provides the features you’d expect: the ability to enter 
numbers and formulas, have calculations update as the numbers change, format the 
results for attractive reporting, and more. 

As with text documents, most people need to do only a few things with a spreadsheet. This 
chapter looks at the basic operations of Calc, including creating workbooks, putting data into 
them, and printing them. 

How do I start Calc? 
You can open Calc in a number of different ways. If QuickStarter is running, right-click it and 
choose Spreadsheet to open Calc with a new blank spreadsheet. Choose Open File from 
QuickStarter and pick an existing Calc or Excel workbook to open Calc with that workbook 
loaded. A third choice with QuickStarter is to choose From Template, and then choose a Calc 
template; that opens Calc with a new workbook based on the chosen template. 

 
Calc uses the term “spreadsheet” to refer to the type of document it  
creates. Microsoft Excel prefers “workbook.” The two terms are used 
interchangeably here. 

If you have another OpenOffice.org application open, choose File | New | Spreadsheet 
from the menu or long click the New button on the Function toolbar and choose Spreadsheet 
to open Calc with a blank spreadsheet. Choose File | Open or the Open button to open Calc 
with an existing workbook. 

Finally, depending on your operating system, you may be able to open Calc from a menu. 
In Windows, choose Start | Programs | OpenOffice.org <version> | OpenOffice.org Calc. 

What do I see when I first open Calc? 
The first time you open Calc, the Stylist and Navigator will probably be open. (See Chapter 5, 
“Making Life Easier with Templates and Styles,” for details on the Stylist and Chapter 4, “The 
OpenOffice.org Interface,” for information about the Navigator.) The workbook is zoomed to 
fit the entire width of your screen.  

Figure 1 shows the initial layout of Calc. 
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Figure 1. By default, Calc opens with both the Stylist and Navigator displayed and 
four toolbars docked, three at the top and one at the left. 

Four toolbars are docked by default. The Function toolbar is beneath the menu and 
includes common operations such as New, Open, Save, and Print, as well as Cut, Copy, Paste, 
and others. Docked beneath the Function toolbar is the Spreadsheet Object Bar. It has controls 
for font attributes (including font name, font size, bold, italic, and so forth), alignment, 
formatting of numbers, and more. 

The third toolbar docked at the top is the Formula Bar. This one is different from the 
others in a couple of ways. First, it can’t be undocked. You can hide it using View | Toolbars | 
Formula Bar, but you can’t undock it and put it elsewhere. Second, the textbox that makes up 
the largest portion of the Formula Bar changes size as the width of the Calc window changes. 
The Formula Bar contains controls used in entering values and formulas. 
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Finally, the Main toolbar is docked at the left. It contains controls for adding other kinds 
of objects to a spreadsheet, to check spelling, for managing data stored in a spreadsheet, and 
more. (The Main, Function, and Object toolbars can be hidden. See Chapter 4, “The 
OpenOffice.org User Interface,” for details.) 

Beneath the Formula Bar are column letters. Click a column letter to highlight the entire 
column. Right-click a column letter to see a shortcut menu of column operations.  

Similarly, to the right of the Main toolbar are row numbers. Click a row number to 
highlight the entire row. Right-click a row number to see a shortcut menu of row operations. 

At the bottom of the Calc window, there are tabs for the individual worksheets in the 
workbook. Click a tab to switch to that worksheet. A set of “VCR buttons,” to the left of the 
tabs, controls the tabs you see, though they don’t actually switch sheets. 

How do I create new spreadsheets? 
As described in “How do I start Calc?” earlier in this chapter, you can create a new workbook 
in several ways when you open Calc. The same techniques work to create another new 
workbook once you’re working in Calc. 

How do I enter data? 
As in other spreadsheet applications, you put data into a cell by setting focus to that cell (either 
by clicking into it or by navigating to the cell with the keyboard) and typing in the data.  

Calc examines what you enter and formats it appropriately. The formatting chosen is 
based both on the content and on the language settings. For example, with US English, 
entering 1.24 results in a number, but with German, it interprets 1.24 as a date and converts it 
to 01.01.2024. 

You can format cells (see “How do I format my data?” later in this chapter) to clarify the 
meaning of a particular value. 

How do I edit data? 
As you enter data, it displays both in the cell itself and in the input line section of the Formula 
Bar. To edit a value, you need to set focus to the input line and edit the value shown there. 

While you type or edit, the buttons next to the input line change to include a red “X” for 
cancel, and a green check mark to accept the entry (shown in Figure 2). You can also accept 
an entry by pressing Enter or navigating to another cell. 

 
Figure 2. While you’re entering or editing a value, the Formula bar includes buttons to 
accept or reject the entry. The Sheet Area drop-down list on the left indicates which 
cell you’re working on. 

How do I enter a series of numbers quickly? 
It’s common when creating a worksheet to enter a series of values in a row or column, or to 
put the same value in a series of cells in a row or column. For example, you might want to 
label a series of rows with the names of the months. Calc makes tasks like this a breeze. 
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Enter the first value in the appropriate cell, and then click the cell. The cell is highlighted 
and in the lower right corner, there’s an extra handle (Figure 3.). Grab the handle and drag 
down the column or across the row where you want the series of values. As you drag, a tooltip 
shows you the value to be inserted in the last cell of the range. When you release, the values 
are inserted. This technique works with numbers, dates, month names, days of the week, and 
even strings that begin or end with a number like “1st quarter” or “Area 1.” For other kinds of 
values where Calc can’t figure out how to increment, the same technique copies the original 
value to each cell in the range. There may be times where you want to copy numbers or dates 
to each cell in a range rather than incrementing. You can still drag, but in that case, hold down 
the Ctrl key while dragging. 

 
Figure 3. Grab the square handle at the bottom right of the highlighted cell and drag 
to autofill a row or column. 

In other cases, you may need more control than simply adding 1 to the value. Highlight 
the range of cells, including the initial value. Choose Edit | Fill | Series from the menu to open 
the Fill Series dialog (Figure 4). In the dialog, you indicate how to compute the successive 
values. Choose Linear to add a fixed amount (specified by Increment) or Growth to multiply 
the value by the increment. When you choose Date, the Time unit option buttons become 
available and you can choose to increment by days, weekdays, months, or years. 

 
Figure 4. The Fill Series dialog lets you determine how to modify values when 
copyiing to each cell in a range. 

How do I enter formulas? 
What makes spreadsheet applications so useful is the ability to enter formulas that are 
evaluated regularly. To enter a formula, you need to tell Calc what you’re doing. The easiest 
way to do so is to begin with an equal sign. You can either type the equal sign or click the “=” 
button on the Formula Bar (Figure 5). 
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Figure 5. When you’re not editing, the formula bar includes an equal sign to begin a 
formula, and a sum button to simplify entering formulas for totals. 

Once you have the equal sign, you can type the actual formula or create it by pointing and 
clicking. As in other spreadsheets, the formula can refer to other cells. To enter a formula with 
the keyboard, use the arrow keys to navigate to the appropriate cell. Next, type the operator to 
follow that cell reference, and then navigate to the next cell in the formula. When the formula 
is complete, press Enter or click the check mark in the Formula Bar. 

By default, when you refer to other cells by pointing with the mouse or the keyboard, you 
get a relative reference. Relative references are adjusted when a formula is copied or moved. 
Suppose cell C2 contains the formula =A2+B2. If you copy the formula to cell C3, it becomes 
=A3+B3. 

In some situations, you want to refer to the same cell, even if a formula is copied or 
moved. Such a reference is called an absolute reference. You specify an absolute reference by 
putting a “$” before each component of the cell address. For example, an absolute reference to 
cell A3 is written $A$3. 

It’s also possible to mix relative and absolute references, making the column relative and 
the row absolute or vice versa. In that case, only the relative portion of the address changes 
when the formula is copied or moved. For example, $A3 refers absolutely to column A, but 
has a relative reference to row 3. If the formula containing this reference is in cell D3, and is 
copied to D4, the reference changes to $A4. However, copying the formula to cell E3 leaves 
the reference to $A3 unchanged. 

 
You can change the type of a reference without typing the dollar signs. 
Position the cursor in the input line anywhere within a reference (including 
right after it) and press Shift-F4 to cycle through the choices. For example, if 
the reference is initially A3, pressing Shift-F4 once changes it to $A$3. The 
second Shift-F4 changes it to A$4, a third makes it $A4, and a fourth Shift-
F4 returns to the original A4. 

Using functions in formulas 
Calc includes many functions that perform a variety of calculations. You can simply type in 
the function name and its arguments, but there are easier ways to make sure you get it right. 

The easiest function to include is SUM(), which totals all the cells provided to it. To put a 
total into a cell, click the Sum button (the sigma symbol) on the Formula bar. Calc inserts a 
formula, totaling the column containing the formula. It includes all cells from the first one in 
the column that contains a number down to the cell immediately above the formula. For 
example, in Figure 6, the Sum button was clicked with focus in cell B8. The formula inserted 
was =SUM(B4:B7). 
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Figure 6. The Sum button on the Formula Bar makes it easy to set up formulas  
for totaling. 

You’re not restricted to the specified range when you use the Sum button. Once the 
formula appears, you can change the range just as you would with any other function. (See the 
next section “Specifying ranges and multiple values for functions.”) 

For other functions, you can use the Functions AutoPilot. To start it, click the 
AutoPilot:Functions button in the Formula Bar (immediately to the left of the Sum button). 
The AutoPilot (Figure 7) shows all available functions along with information about the 
selected function. Choose the function you want. Use the Category drop-down list to make it 
easier to find the right function. 

 
Figure 7. The Functions AutoPilot helps you construct a formula involving a function. 
First, choose the function you want to use. 

Once you have the right function, press Next to move to the arguments page (Figure 8) of 
the AutoPilot. On this page, you specify the values the function should use in the calculation. 



Chapter 8: Creating Simple Spreadsheets  127 

 

The appearance of the page depends on the function chosen. In Figure 8, you can specify up to 
30 arguments for the Average function. 

 
Figure 8. The arguments page of the Functions AutoPilot lets you specify what values 
the function uses in its calculations. 

 
Once you move to the arguments page, the Category drop-down list 
automatically changes to the category containing the specified function. 

There are four ways of specifying each argument. First, you can simply type it into the 
appropriate position in the Formula text box. Alternatively, you can type it in the text box for 
that argument. In either case, what you type can be actual values or cell references. However, 
you can also specify cell references by pointing. If you can’t see the cells you want, click the 
Shrink button to the right of the text box for the argument to reduce the AutoPilot to toolbar 
size (Figure 9), and then point to the cell or range using the mouse or keyboard. When you 
complete the range, click the same button (now labeled “Maximize”) to restore the AutoPilot. 

 
Figure 9. The Shrink button lets you turn the Functions AutoPilot into a toolbar so you 
can specify cells by pointing. 

The final option for any argument is to use another function to specify it. To do so, click 
the function button (labelled “fx”) to the left of the argument’s text box. This returns you to the 
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first page of the AutoPilot, but whatever you choose becomes an argument to the function you 
already chose. In this way, you can nest function calls as needed. 

As you work in the AutoPilot, you can see the formula being constructed and the  
current value for that formula. When the formula for the function call is complete, click OK  
to close the AutoPilot and insert the new formula in the cell that had focus when you opened 
the AutoPilot. 

Specifying ranges and multiple values for functions 
Many functions operate on multiple values or groups of values. When a function requires 
several values to perform its calculation, separate the arguments with semi-colons. For 
example, the CONCATENATE() function lets you combine up to 30 text values into a single 
string. A call to CONCATENATE() might look like this: 

=CONCATENATE(A4;" and ";A5) 

Other functions like SUM() and AVERAGE() operate on ranges (groups of cells). You 
indicate a range by specifying opposite corners separated by a colon. A range can include cells 
from just one row, just one column, or multiple rows and columns. However, a range is always 
rectangular. For example, B3:D14 specifies the rectangle bounded by B3, D3, B14, and D14. 

You can specify a range by pointing to it with the mouse or keyboard. With the mouse, 
click into one corner, and then Shift-Click the opposite corner. With the keyboard, navigate to 
one corner, and then hold down the Shift key while you navigate to the opposite corner. 

 
The order in which you specify the corners of a range doesn’t matter, nor 
does it matter whether you specify upper left and lower right, or upper right 
and lower left. Calc always adjusts the range to the form “upper left:lower 
right” before inserting it into a formula. 

In some cases, a function can work with multiple ranges. (For example, the formula 
SUM(A1:B10; A20:B50) adds the values in the two ranges of cells while ignoring the cells in 
between the two ranges.) To specify multiple ranges with the mouse, choose one as above and 
use Ctrl-Click to begin the next range. Calc automatically inserts the semi-colon needed to 
separate the ranges. With the keyboard, you have to type the semi-colon yourself. 

Naming ranges 
If you’re going to use a particular range repeatedly, you can make things easier by giving the 
range a name that you can then use in formulas. To do so, highlight the range and choose 
Insert | Names | Define from the menu. The Define Names dialog (Figure 10) opens. The 
highlighted range shows in the Range textbox. Type the name for the range and click Add to 
define the range. 
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Figure 10. This dialog lets you assign a name to a range, so you can refer to it by 
name and don’t have to keep selecting it. 

You don’t actually have to highlight the range you want before opening the dialog. Once 
you enter a name for a range, you can click back into the workbook and select the range to be 
named. When you do so, the dialog shrinks to toolbar size. You can force it to shrink by 
clicking the Shrink button next to the range textbox. When you select the right range, click the 
same button to expand the dialog. 

Once you define a range, it’s listed in the Range Names section of the Navigator. You can 
highlight a range by double-clicking its name in the Navigator. You can also drag-and-drop 
the name of a range into a formula. 

If you use a named range in a formula and later change the range assigned to that name 
(that is, point the name to a different range), the formula refers to the new range. Similarly, if 
you insert or delete a row or column within the named range, the range adjusts itself. 

Referring to other worksheets 
A formula can refer to cells in other worksheets of the workbook. You set this up by pointing 
to the appropriate cells or by typing in the references. The format for referring to a cell or 
range in another worksheet is: 

SheetName.Cell 

or 

SheetName.Range 

For example, a formula on Sheet1 of a workbook would refer to the range B2:C7 of 
Sheet2 of the workbook as Sheet2.B2:C7. 
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How do I format data? 
As in Writer, it’s a good idea to use styles to format data rather than formatting it directly. 
Styles make it easier to make across-the-board changes. Unlike Writer, however, Calc includes 
only a few built-in styles. See Chapter 5, “Making Life Easier with Templates and Styles,” for 
instructions on defining new styles and modifying existing styles. Here I look at some of the 
things you’re likely to want to change, whether in a style or directly. 

Setting cell formats 
If you don’t specify otherwise, Calc examines the data you type in and chooses a format based 
on the data itself. For example, when you type something Calc recognizes as a number, it uses 
a numeric format. If you precede a number with a dollar sign (using US settings), Calc 
recognizes currency and formats the cell as such. When you type something Calc identifies as 
a date, it uses a date format for that cell, and so forth. 

However, sometimes you want something different from the default, whether it’s to 
format a particular value differently than Calc assumes, or to make a different choice of 
numeric, currency, or date format. To change the format of a cell or range of cells, choose 
Format | Cells from the menu or from the shortcut menu. The Cell Attributes dialog opens—
use the Numbers tab (Figure 11) to choose the overall formatting for a cell or range. 

 
Figure 11. The Numbers tab of the Cell Attributes dialog lets you indicate the type of 
value in a cell or range of cells and specify the formatting to use. 
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Dates are stored as numeric values (with 31-Dec-1899 as day 1). If you 
format a cell containing a date using one of the Numeric formats, you see a 
number rather than a date. 

A large number of formats are predefined and available on the Numbers tab. However, if 
what you need isn’t included, you can define your own format. The easiest way to define your 
own format is to start with one similar to what you want and edit the format code to get 
exactly what you want.  

Format codes use special characters to indicate the various components of the value. For 
example, “#” indicates a digit with leading and trailing zeroes suppressed, while “YYYY” 
indicates a four-digit year. The Help topic, “Number Format Codes,” includes a complete list 
of format codes. 

Calc lists format codes you define in the User-defined category, as well as in the category 
they best fit in. (For example, those that include date components land in the Date category.) 

You can make life easier by adding a comment to your custom format codes, explaining 
their purpose or use. To do so, click the Edit Comment button (the yellow speech balloon) 
next to the Format code text box. The description beneath the Format code text box becomes 
editable, as in Figure 12. When you finish editing, click the Add (check mark) button or click 
OK to close the dialog. 

 
Figure 12. To change the comment for a format code, click the yellow  
speech balloon. 
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You set the format for an entire column or row by clicking the column or row label before 
choosing Format | Cells. 

Setting text orientation 
Calc lets you orient text vertically as well as rotate the contents of a cell. Use the Alignment 
tab (Figure 13) of the Cell Attributes dialog. For vertical text, click the large vertical button 
that says “ABCD” vertically. Figure 14 shows an example. 

 
Figure 13. The Text direction section of the Alignment tab lets you make text vertical 
or rotate it as you wish. 

 
Figure 14. Using vertical text is as easy as clicking the Vertical Text button on the 
Alignment tab. 
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To rotate an item, you need to specify two things, the amount of rotation and where to 
start. You can specify the angle of rotation in one of two ways, either by typing it into the 
Degrees text box or by clicking in the circle. Whichever you choose, the sample text 
(“ABCD”) inside the circle displays with that rotation. 

The Reference edge option buttons let you determine where the rotated item appears. By 
default, the text is anchored to the bottom edge of the cell and rotates outward from there. The 
middle button rotates the text from the top edge of the cell, while the right button rotates only 
within the cell. With the first two settings, rotated text can extend beyond its cell. Figure 15 
shows the same value rotated 45 degrees using each of the Reference edge settings. 

 
Figure 15. The Reference edge setting for rotated text determines where it’s 
anchored. Here, the left cell uses the bottom edge, the middle cell uses the top edge, 
and the right cell keeps rotated text in the cell. 

Conditional formatting 
In some situations, you want to display data differently depending on its value. The most 
common case is showing negative numbers in red. To do this, use the Format Cells dialog; on 
the Numbers tab, select the Negative numbers red check box. Some people prefer to use 
parentheses around negative numbers. There are some built-in formats to provide this style 
(look in the Currency category). You can also create a custom format using a format code like 
this: 

0;(-0) 

The first 0 indicates formatting for positive numbers, while the second shows how to 
format negative numbers. 

In other situations, the decision about how to format values is more complex than just 
positive or negative. For example, you might want to make all numbers above a certain value 
or all dates in a certain range stand out. To do this kind of formatting, you must first create a 
style with the formatting characteristics you want to use to make those values stand out. (See 
Chapter 5, “Making Life Easier with Templates and Styles.”) Next, choose Format | 
Conditional Formatting from the menu. The Conditional Formatting dialog (Figure 16) opens. 
You can specify up to three distinct conditions for the highlighted range. In Figure 16, cells 
with a value of 180 or more display bold. 
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Figure 16. The Conditional Formatting dialog lets you match data values to styles, so 
different values use different formatting. 

You can specify another cell (either by typing or by pointing to it) rather than a particular 
value to trigger the condition. You can also put a formula in the value text box, so you can 
compare to the result of a calculation.  

If you apply conditional formatting to a range of cells, remember to make cell ranges in 
the value relative or partially relative if you want to refer to a different cell for each cell in the 
range being formatted. For example, Figure 17 shows some population data for the United 
States. The current population in column D has conditional formatting that makes it red if less 
than half the population is female. Figure 18 shows the condition set up for that. 

 
Figure 17. The total population of states where less than half the population is female 
display in red. The condition needed is shown in Figure 18. 
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Figure 18. The condition applied to column D of Figure 17 uses the RedCell style for 
any cell whose value is more than half of the corresponding cell in column G. 

How do I set column width? 
A spreadsheet usually looks better with columns sized to fit their contents. The easiest way to 
resize a column is to position the mouse on the space between that column and the one to its 
right, so the pointer changes into a sizer, and then double click, which sets the column to the 
width necessary for its contents. If you highlight multiple columns when doing this, they all 
resize to fit their contents. Figure 19 shows the mouse positioned to resize column F. 

 
Figure 19. Put the mouse between columns to resize the column to the left. If you 
double-click, the column is set to fit its contents. 

You can also resize columns by dragging. Again, position the mouse between columns, 
and then click and drag to the desired size. A tooltip appears telling you the column width as 
you go. 

A third approach is to click the column header to select the entire column, and then 
choose Format | Column | Width or Format | Column | Optimal Width from the menu or 
Column Width or Column Optimal Width from the shortcut menu. When you choose Format | 
Column | Width or Column Width, the Column Width dialog (Figure 20) appears. Specify the 
desired width. To return to the default size, select the Default Value check box. 
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Figure 20. As soon as you change the width value in the Column Width dialog, the 
Default value check box is cleared. Select it to put the default width back into the  
text box. 

When you choose Format | Column | Optimal Column Width or Optimal Column Width, 
the Optimal Column Width dialog (Figure 21) appears. In this dialog, you specify how much 
space to add to the width of the widest cell in the column to determine the total column width. 
Again, the Default value check box lets you restore the default setting. 

 
Figure 21. The Optimal Column Width dialog specifies how much space to add to the 
widest cell to get the column width. 

 
Be careful. If you right-click a column header and set the width without 
clicking the column first, the new width applies to the column (or columns) 
containing the currently selected cell (or cells), which is not necessarily the 
one on which you right-clicked. 

How do I center a heading above a bunch of columns? 
Many spreadsheets use one or more rows at the top as headings for the entire document. It’s 
useful to be able to center those headings across all the columns in use. While you can do this, 
more or less, by trial and error, Calc offers an easy way to get it right. 

In the row where a heading appears, select the cells above all the relevant columns  
(those above which the header should be centered). Choose Format | Merge Cells | Define 
from the menu. This merges those cells into a single cell. Choose Align Center Horizontally 
from the Spreadsheet Object Bar or choose Center alignment on the Alignment tab of the  
Cell Attributes dialog (Format | Cells from the menu). Figure 22 shows an example of  
this technique. 
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Figure 22. To center a heading over a group of columns, merge the cells, and then 
choose Center alignment. 

How do I move or copy cell contents using the mouse? 
When you want to move or copy the contents of a group of cells in Calc, it’s easy. Highlight 
all the cells in the group and drag (to move) or Ctrl-drag (to copy) them to the new location. 
However, moving or copying a single cell is a little tricky. 

If the cell to be moved or copied holds a number or text, you can triple-click in the cell 
and drag (to copy) or Shift-drag (to move) that value. When a formula is involved, however, 
that approach prevents the formula’s relative references from adapting to the move. Instead, 
click in the cell and, holding the left mouse button down, drag to the right until both that cell 
and the next cell are highlighted. Next, move the mouse back to the left until only the desired 
cell is highlighted. Now you can drag (to move) or Ctrl-drag (to copy) as with a range of cells. 

How do I copy the value of a cell rather than the formula? 
By default, when you copy a cell containing a formula to another cell, the formula is pasted 
into the new cell (adjusted appropriately if it uses relative references). There are times, though, 
when you want to copy the result of the calculation, not the calculation itself. 

Calc gives you tremendous control over what is pasted, if you ask. When you use Edit | 
Paste, the Paste button on the Function toolbar, or the Paste item on the shortcut menu, Calc 
pastes the formula. However, if you choose Edit | Paste Special or Paste Special from the 
shortcut menu, the Paste Special dialog (Figure 23) appears. Clear the Paste All check box (if 
it’s selected) and clear Formulas. Make sure Numbers is selected, and then click OK. 

To duplicate exactly the Values choice in Microsoft Excel’s Paste Special dialog, clear 
everything except Numbers. 

How do I switch rows and columns? 
Sometimes, you find after you lay out the information in a spreadsheet that you prefer to have 
what’s in columns become rows and what’s in rows become columns. For example, you might 
start tracking employee information by using one column for each employee, and having rows 
for things like name, social security number. and the like. After the number of employees 
grows a little, it may become clear that it would be better to use one row per employee with 
one column for each piece of information. 

This kind of change is called a transposition and you use the Paste Special dialog (Figure 
23) to perform it. To transpose data in place, highlight the data, cut it (Ctrl-X, Edit | Cut from 
the menu, or Cut on the Function toolbar or shortcut menu). Next, choose Edit | Paste Special 
from the menu or Paste Special on the shortcut menu, and select the Transpose check box. 
Click OK to paste the transposed data. 
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Figure 23. The Paste Special dialog lets you decide what is pasted. Clear the 
Formulas check box to copy the result of a formula rather than the formula itself. 

How do I change the number of worksheets in  
a workbook? 
By default, new spreadsheets are created with three worksheets. If you need additional sheets 
in a workbook, you can add them by choosing Insert | Sheet from the menu or by choosing 
Insert Sheet from the shortcut menu for the sheet tabs. In either case, the Insert Sheet dialog 
(Figure 24) opens. Specify the number of sheets to add and whether the new sheets go before 
or after the current worksheet. 

 
Figure 24. The Insert Sheet dialog lets you add one or more new worksheets to a 
workbook. They can come from another workbook. 
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To remove a worksheet, click its tab, and then choose Edit | Sheet | Delete from the menu 
or Delete Sheet from the tab’s shortcut menu. In either case, a confirmation message displays. 

How do I change a worksheet’s name? 
When you create a new workbook, Calc names the worksheets Sheet1, Sheet2 and so forth. To 
give them meaningful names, choose Format | Sheet | Rename from the menu or Rename Sheet 
from the shortcut menu for the sheet’s tab. In the Rename Sheet dialog that appears, type the 
new name. 

How do I move a worksheet within a workbook? 
Sometimes, you find the order of sheets within a workbook is wrong. To change the order of 
worksheets, click the tab for the sheet you want to move, and then choose Edit | Sheet | 
Move/Copy from the menu or Move/Copy Sheet from the shortcut menu for the tab. The 
Move/Copy Sheet dialog (Figure 25) appears. In the Insert before list, choose the new 
position for the sheet.  

 
Figure 25. Use this dialog to move a worksheet within a workbook or to make a copy 
of a worksheet in another workbook. 

You can also use this dialog to make a copy of a worksheet. Choose another workbook or 
“- new document -” from the To document drop-down list, and then choose the position for 
the worksheet in that workbook. For a new document, the only choice is “- move to end 
position -”. 

How do I print my spreadsheet? 
Similar to Writer documents, the easiest way to print a spreadsheet is clicking the Print  
button on the Function toolbar. Doing so prints to the default printer (or if you previously 
printed this spreadsheet to another printer, it goes to that printer). Only the used area of the 
spreadsheet prints. 

For more control, choose File | Print and the Print dialog appears. You can choose a 
printer, as well as indicate whether to print the whole spreadsheet, selected pages, or the 
currently selected portion. 
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The Format menu offers a couple of ways to gain additional control over printing. Choose 
Format | Page to open the Page Style dialog. The Sheet tab (Figure 26) includes several 
options for printing. Select Grid to include gridlines in your output; clear Zero values to 
replace zeroes with white space in your output. If you want to print out the formulas behind a 
spreadsheet rather than the results, select Formulas (but realize that many of your columns 
may not be wide enough to show the formulas they contain). 

 
Figure 26.The Sheet tab of the Page Style dialog lets you specify printing options. 

The Header and Footer tabs of the Page Style dialog let you specify page headers and 
footers to appear on each page of your output. In the dialog itself, you indicate the position on 
the page for the header or footer. Click the Edit button to specify the content. Figure 27 shows 
the Header dialog set to include “Page x of y” information at the top left of each page, as well 
as the sheet name (which is centered in the header by default). 
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Figure 27. The Header and Footer dialogs let you put information at the top or bottom 
of each page. 

Once you print or preview (see “How do I preview what will get printed?” in the next 
section) a spreadsheet, subtle page dividers appear. The dividers are grid lines darker than the 
default light gray. In Figure 28, the page break occurs between columns G and H. You can 
turn this feature off on the View page of the Spreadsheet section of the Options dialog (Tools | 
Options)--clear the Page breaks check box. Alternatively, you can change the color of the 
regular grid lines on the same page; when you do so, the page breaks are still dark gray. 

 
Figure 28. Once you print a workbook, page dividers appear as slightly darker grid 
lines. Here, the page break falls between columns G and H. 

How do I decide what gets printed? 
You can determine what prints rather than letting Calc do it automatically. Highlight the range 
or ranges you want to print and choose Format | Print Ranges | Define from the menu. You can 
choose all the relevant ranges before choosing the menu item, or do them one at a time. In the 
latter case, use Format | Print Ranges | Define for the first range, and then use Format | Print 
Ranges | Add for subsequent ranges. 

Regardless of how you specify the ranges, when you print the spreadsheet, only the 
specified ranges print. Note that the individual ranges print in their normal positions—they’re 
not put closer together to fill the page. 

To restore normal printing, choose Format | Print Ranges | Remove. 
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How do I preview what will print? 
You can save a lot of paper by previewing your output before actually printing it. Choose File 
| Page Preview from the menu and Calc switches to preview mode. The first page of output 
displays and the Page View Object Bar (Figure 29) appears. 

 
Figure 29. When you choose Page Preview from the menu, the Page View Object 
Bar lets you navigate within your preview. 

The leftmost group of buttons is for navigating pages. You can move one page at a time or 
to the first or last page. The magnifying glass buttons zoom in and out. 

Summary 
Creating a basic spreadsheet that performs simple calculations isn’t too hard. In the next 
chapter, I look at using Calc as a simple database. 

 

 
 
 

Updates and corrections to this chapter can be found on Hentzenwerke’s web site, 
www.hentzenwerke.com. Click “Catalog” and navigate to the page for this book. 

www.hentzenwerke.com
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